Brooks® Expert Support Tool (BEST)
Version 5.4.0.0
Software for Brooks Devices
(SLA Rev A, Quantim B)
### Essential Instructions
*Read before proceeding!*

Brooks Instrument designs, manufactures and tests its products to meet many national and international standards. These products must be properly installed, operated and maintained to ensure they continue to operate within their normal specifications. The following instructions must be adhered to and integrated into your safety program when installing, operating and maintaining Brooks Instrument products.

- To ensure proper performance, use qualified personnel to install, operate, update, program and maintain the product.
- Read all instructions prior to installing, operating and servicing the product. If this instruction manual is not the correct manual, please see back cover for local sales office contact information. Save this instruction manual for future reference.

⚠️ **WARNING:** Do not operate this instrument in excess of the specifications listed in the Instruction and Operation Manual. Failure to heed this warning can result in serious personal injury and / or damage to the equipment.

- If you do not understand any of the instructions, contact your Brooks Instrument representative for clarification.
- Follow all warnings, cautions and instructions marked on and supplied with the product.

**WARNING:** Prior to installation ensure this instrument has the required approval ratings to meet local and national codes. Failure to heed this warning can result in serious personal injury and / or damage to the equipment.

- Install your equipment as specified in the installation instructions of the appropriate instruction manual and per applicable local and national codes.
- Connect all products to the proper electrical and pressure sources.
- Operation: (1) Slowly initiate flow into the system. Open process valves slowly to avoid flow surges. (2) Check for leaks around the flow meter inlet and outlet connections. If no leaks are present, bring the system up to the operating pressure.
- Please make sure that the process line pressure is removed prior to service. When replacement parts are required, ensure that qualified people use replacement parts specified by Brooks Instrument. Unauthorized parts and procedures can affect the product’s performance and place the safe operation of your process at risk. Look-alike substitutions may result in fire, electrical hazards or improper operation.
- Ensure that all equipment doors are closed and protective covers are in place to prevent electrical shock and personal injury, except when maintenance is being performed by qualified persons.

**WARNING:** For liquid flow devices, if the inlet and outlet valves adjacent to the devices are to be closed for any reason, the devices must be completely drained. Failure to do so may result in thermal expansion of the liquid that can rupture the device and may cause personal injury.

### European Pressure Equipment Directive (PED)
All pressure equipment with an internal pressure greater than 0.5 bar (g) and a size larger than 25 mm or 1" (inch) falls under the Pressure Equipment Directive (PED).

- The Specifications Section of this manual contains instructions related to the PED directive.
- Products described in this manual are in compliance with EN directive 2014/34/EU.
- All Brooks Instrument Flowmeters fall under fluid group 1.
- Products larger than 25 mm or 1" (inch) are in compliance with PED category I, II or III.
- Products of 25 mm or 1" (inch) or smaller are Sound Engineering Practice (SEP).

### European Electromagnetic Compatibility (EMC)
The Brooks Instrument (electric/electronic) equipment bearing the CE mark has been successfully tested to the regulations of the Electro Magnetic Compatibility (EMC directive 2014/30/EU).
Special attention however is required when selecting the signal cable to be used with CE marked equipment.

#### Quality of the signal cable, cable glands and connectors:
Brooks Instrument supplies high quality cable(s) which meets the specifications for CE certification.

If you provide your own signal cable you should use a cable which is overall completely screened with a 100% shield.

- “D” or “Circular” type connectors used should be shielded with a metal shield. If applicable, metal cable glands must be used providing cable screen clamping.
- The cable screen should be connected to the metal shell or gland and shielded at both ends over 360 Degrees.
- The shield should be terminated to an earth ground.

Card Edge Connectors are standard non-metallic. The cables used must be screened with 100% shield to comply with CE certification.

The shield should be terminated to an earth ground.

For pin configuration: Please refer to the enclosed Instruction Manual.

### ESD (Electrostatic Discharge)
⚠️ **CAUTION:** This instrument contains electronic components that are susceptible to damage by static electricity. Proper handling procedures must be observed during the removal, installation or other handling of internal circuit boards or devices.

#### Handling Procedure:
1. Power to unit must be removed.
2. Personnel must be grounded, via a wrist strap or other safe, suitable means before any printed circuit card or other internal device is installed, removed or adjusted.
3. Printed circuit cards must be transported in a conductive container. Boards must not be removed from protective enclosure until immediately before installation. Removed boards must immediately be placed in protective container for transport, storage or return to factory.

#### Comments
This instrument is not unique in its content of ESD (electrostatic discharge) sensitive components. Most modern electronic designs contain components that utilize metal oxide technology (NMOS, SMOS, etc.). Experience has proven that even small amounts of static electricity can damage or destroy these devices. Damaged components, even though they appear to function properly, exhibit early failure.
Dear Customer,

We recommend that you read this manual in its entirety as there have been some changes since previous versions. This will enable efficient and proper use of the Brooks Expert Support Tool software. Should you require any additional information concerning Brooks Expert Support Tool, please feel free to contact your local Brooks Sales and Service Office; see back cover for contact information, or visit us on the web at www.BrooksInstrument.com. We appreciate this opportunity to service your fluid measurement and control requirements, and trust that we will be able to provide you with further assistance in future.

Yours sincerely, Brooks Instrument
# Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Introduction</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Description</td>
<td>1-1</td>
</tr>
<tr>
<td>1.1</td>
<td>How to Use This Manual</td>
<td>1-2</td>
</tr>
<tr>
<td>1.2</td>
<td>Integrated Help</td>
<td>1-2</td>
</tr>
<tr>
<td>1.3</td>
<td>Theory of Operation</td>
<td>1-2</td>
</tr>
<tr>
<td>Chapter 2</td>
<td>Installation</td>
<td>2-1</td>
</tr>
<tr>
<td>2.1</td>
<td>Hardware Requirements</td>
<td>2-1</td>
</tr>
<tr>
<td>2.2</td>
<td>System Requirements</td>
<td>2-1</td>
</tr>
<tr>
<td>2.3</td>
<td>Installing the Brooks Expert Support Tool Application</td>
<td>2-2</td>
</tr>
<tr>
<td>2.4</td>
<td>License Installation</td>
<td>2-4</td>
</tr>
<tr>
<td>2.5</td>
<td>Uninstalling the Brooks Expert Support Tool Application</td>
<td>2-6</td>
</tr>
<tr>
<td>2.6</td>
<td>Connecting the PC to the Device</td>
<td>2-6</td>
</tr>
<tr>
<td>2.6.1</td>
<td>Connection Hardware Requirements</td>
<td>2-7</td>
</tr>
<tr>
<td>2.6.2</td>
<td>Connection Procedure</td>
<td>2-8</td>
</tr>
<tr>
<td>2.6.3</td>
<td>Disconnecting the PC from the Device</td>
<td>2-10</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>Basic Operations</td>
<td>3-1</td>
</tr>
<tr>
<td>3.1</td>
<td>Main Screen</td>
<td>3-1</td>
</tr>
<tr>
<td>3.2</td>
<td>Attaching to a Device</td>
<td>3-3</td>
</tr>
<tr>
<td>3.3</td>
<td>Main Graph</td>
<td>3-4</td>
</tr>
<tr>
<td>3.4</td>
<td>Closing the Session with the Device and Exiting BEST</td>
<td>3-5</td>
</tr>
<tr>
<td>3.5</td>
<td>Brooks Expert Support Tool Conventions</td>
<td>3-5</td>
</tr>
<tr>
<td>3.6</td>
<td>Menu Bar</td>
<td>3-6</td>
</tr>
<tr>
<td>Chapter 4</td>
<td>File Menu</td>
<td>4-1</td>
</tr>
<tr>
<td>Chapter 5</td>
<td>Help Menu Item</td>
<td>5-1</td>
</tr>
<tr>
<td>5.1</td>
<td>About Window</td>
<td>5-1</td>
</tr>
<tr>
<td>5.1.1</td>
<td>License Info Window</td>
<td>5-2</td>
</tr>
<tr>
<td>5.1.2</td>
<td>Install License Window</td>
<td>5-2</td>
</tr>
<tr>
<td>5.1.3</td>
<td>EULA Window</td>
<td>5-3</td>
</tr>
<tr>
<td>5.2</td>
<td>User Manual Menu</td>
<td>5-3</td>
</tr>
<tr>
<td>5.3</td>
<td>ReadMe Menu</td>
<td>5-3</td>
</tr>
<tr>
<td>Chapter 6</td>
<td>Window Menu</td>
<td>6-1</td>
</tr>
<tr>
<td>Chapter 7</td>
<td>Settings</td>
<td>7-1</td>
</tr>
<tr>
<td>7.1</td>
<td>Graph Options</td>
<td>7-1</td>
</tr>
<tr>
<td>7.2</td>
<td>Reset All User Options</td>
<td>7-2</td>
</tr>
<tr>
<td>7.3</td>
<td>Data Logging Options</td>
<td>7-2</td>
</tr>
<tr>
<td>7.4</td>
<td>User Totalizer Options</td>
<td>7-3</td>
</tr>
<tr>
<td>Chapter 8</td>
<td>Monitoring Menu</td>
<td>8-1</td>
</tr>
<tr>
<td>8.1</td>
<td>Warning Status</td>
<td>8-1</td>
</tr>
<tr>
<td>8.2</td>
<td>Alarm Status</td>
<td>8-1</td>
</tr>
<tr>
<td>8.3</td>
<td>User Totalizer Window</td>
<td>8-3</td>
</tr>
<tr>
<td>8.4</td>
<td>Graph Window</td>
<td>8-3</td>
</tr>
<tr>
<td>Chapter 9</td>
<td>Tools Menu</td>
<td>9-1</td>
</tr>
<tr>
<td>9.1</td>
<td>Pressure Units Calculator</td>
<td>9-1</td>
</tr>
<tr>
<td>9.2</td>
<td>Flow Units Calculator</td>
<td>9-1</td>
</tr>
<tr>
<td>9.3</td>
<td>Temperature Units Calculator</td>
<td>9-2</td>
</tr>
<tr>
<td>9.4</td>
<td>Density Units Calculator</td>
<td>9-2</td>
</tr>
<tr>
<td>Chapter 10</td>
<td>Device Comm Menu</td>
<td>10-1</td>
</tr>
<tr>
<td>10.1</td>
<td>Device Connection Window</td>
<td>10-1</td>
</tr>
<tr>
<td>10.1.1</td>
<td>Connecting to an Unconfigured Device</td>
<td>10-4</td>
</tr>
<tr>
<td>10.2</td>
<td>Terminal Window (License Feature)</td>
<td>10-5</td>
</tr>
<tr>
<td>Chapter 11</td>
<td>Device Config Menu</td>
<td>11-1</td>
</tr>
<tr>
<td>11.1</td>
<td>Dump Files</td>
<td>11-2</td>
</tr>
<tr>
<td>11.2</td>
<td>Device Info</td>
<td>11-4</td>
</tr>
<tr>
<td>11.3</td>
<td>Model Code Window</td>
<td>11-4</td>
</tr>
<tr>
<td>11.4</td>
<td>Protocol Settings Window</td>
<td>11-5</td>
</tr>
</tbody>
</table>
# Table of Contents

11.5 RT Control Mode 11-5  
11.6 Meter Simulate MFC (License Feature) 11-5  
11.7 Alarm Settings 11-7  
11.8 Config Parameters 11-8  

**Chapter 12 Device Control Menu** 12-1  
12.1 Reboot Device 12-1  
12.2 Valve Control 12-1  
12.3 Delta Device Services 12-2  

**Chapter 13 Calibration Menu** 13-1  
13.1 Pressure Controller Setup Diagram 13-1  
13.2 Sensor Zero 13-2  
13.3 Flow Sensor Zero 13-2  
13.4 Pressure Sensor Zero 13-4  
13.5 Analog Output Calibration (License Feature) 13-5  
13.6 Analog Input Calibration (License Feature) 13-10  
13.7 RT/Aux Input Calibration 13-13  
13.8 Cal Pages 13-14  
13.9 Flow Cal Pages 13-14  
13.10 Pressure Cal Pages 13-16  
13.11 Calibration (License Feature) 13-18  
13.11.1 Flow Calibration - SLA Rev A Delta Smart II Devices 13-18  
13.11.2 Pressure Controller Calibration 13-27  
13.11.3 RT Device Calibration 13-27  
13.12 Valve Tuning 13-28  
13.12.1 Checking Offset and Span Values 13-29  
13.12.2 Adjusting Offset and Span Values - Manual Tuning - For MFC Devices 13-30  
13.12.3 Checking and Adjusting Offset & Span Values - Manual Tuning - For Pressure Devices 13-31  
13.12.4 Adjusting the Offset and Span Values - Auto Tuning 13-32  
13.12.5 Dynamically Adjusting the Offset and Span Values During Device Operation 13-34  
13.13 Response Tuning 13-35  
13.13.1 Response Tuning (Flow) 13-35  
13.13.2 Response Tuning (Pressure) 13-41  

**Chapter 14 Viewing and Setting the Device Configuration (SLA Rev A)** 14-1  
14.1 Viewing the Control Response Parameters 14-1  
14.2 Viewing Device Information 14-4  
14.3 Viewing Filter Parameters 14-5  
14.4 Viewing Flow Sensor Parameters 14-5  
14.5 Setting the Output Signal Behavior 14-10  
14.6 Viewing and Setting Pressure Sensor Parameters 14-11  
14.7 Viewing and Setting Setpoint Parameters 14-11  
14.8 Viewing and Setting Valve Parameters 14-12  
14.9 Viewing Selected Live Measurement Parameters 14-16  

**Chapter 15 Viewing and Setting the Device Configuration (Quantim)** 15-1  
15.1 Setting Units of Measure 15-1  
15.2 Viewing and Setting Alarms 15-2  
15.3 Diagnostic Alarm 15-2  
15.4 Configuring Optional Warnings and Alarms 15-3  
15.5 Modifying Standard Alarm Behavior 15-4  
15.6 Viewing the Control Response Parameters 15-5  
15.7 Viewing Device Information 15-6  
15.8 Viewing HART Protocol Parameters 15-7  
15.9 Viewing and Setting Primary and Secondary Output Parameters 15-8  
15.10 Viewing Sensor Parameters 15-10  
15.11 Viewing Setpoint Parameters 15-12  
15.12 Viewing Valve Parameters 15-13  
15.13 Viewing Selected Live Measurement Parameters 15-14
Figures

Figure 1-1 BEST Main Screen 1-1
Figure 2-1 Running Setup.exe as an Admin 2-3
Figure 2-2 Installer Software Component Menu 2-4
Figure 2-3 License Installation Window 2-5
Figure 2-4 License Information Window 2-5
Figure 2-5 3-Wire Communications Cable and Adapter 2-7
Figure 2-6 SLA Rev A Device with Cover Removed 2-8
Figure 2-7 3-wire communications cable attached; black wire toward LEDs 2-9
Figure 2-8 Cable/Adapter Connection to PC 2-9
Figure 3-1 Main Screen with Device Connection Window 3-1
Figure 3-2 Device Connection Window, Device Attached 3-3
Figure 3-3 Executing Mode Window 3-4
Figure 3-4 Idle Mode Window 3-4
Figure 3-5 Graph Window 3-4
Figure 3-6 Example Numeric Up/Down Control 3-5
Figure 4-1 File->Exit Menu 4-1
Figure 5-1 Help Menu 5-1
Figure 5-2 About Window 5-1
Figure 5-3 License Information Window (Your versions may vary) 5-2
Figure 5-4 License Install Window 5-3
Figure 6-1 Window Menu 6-1
Figure 6-2 Cascaded Window Layout 6-2
Figure 6-3 Tiled Window Layout 6-2
Figure 6-4 Minimized Windows 6-3
Figure 7-1 Settings Menu 7-1
Figure 7-2 Graph Options Window 7-1
Figure 7-3 Data Logging Options 7-3
Figure 7-4 User Totalizer Options 7-3
Figure 8-1 Monitoring Menu (not all devices support all menus) 8-1
Figure 8-2 Alarm Status Window, Delta Lite/Smart II Device 8-2
Figure 8-3 Alarm Status Window, Quantim Device 8-2
Figure 8-4 User Totalizer Window 8-3
Figure 8-5 Main Graph Window 8-3
Figure 8-6 Main Graph Window with Cursor 8-5
Figure 8-7 Main Graph Window with Context Menu 8-6
Figure 8-8 Graph Window Zoomed 8-6
Figure 9-1 Tools Menu 9-1
Figure 9-2 Pressure Units Calculator 9-1
Figure 9-3 Flow Units Calculator 9-2
Figure 9-4 Temperature Units Calculator 9-2
Figure 9-5 Density Units Calculator 9-3
Figure 10-1 Device Connection Menu 10-1
Figure 10-2 Device Connection Window, with No Devices Attached 10-1
Figure 10-3 No Device Connected Message 10-2
Figure 10-4 Connection Window, with a Device Attached 10-3
Figure 10-5 Fix Model Code Window 10-4
Figure 10-6 Terminal Window 10-6
Figure 11-1 Device Config Menu (Quantim) 11-1
Figure 11-2 Device Config Menu (SLA Rev A) 11-1
Figure 11-3 Device Config Menu (SLA Rev A, Delta Lite) 11-1
Figure 11-4 BEST Control Message 11-2
Figure 11-5 Dump File Window, SLA Rev A Delta 11-2
Figure 11-6 Dump File Window, Select Pages Form 11-3
Figure 11-7 Device Info Window 11-4
Figure 11-8 Model Code Window 11-4
Figure 11-9 RT Control Mode Window 11-5
Figure 11-10 Meter Simulate MFC Window 11-6
Figure 11-11 Alarm Settings, SLA Rev A/Delta Lite/Smart II Class Devices 11-7
Figure 11-12 Alarm Behavior Settings, SLA Rev A/Delta Lite/Smart II class devices 11-8
Figure 12-1 Device Control Menu 12-1
Figure 12-2 Reboot Device Window 12-2
Figure 12-3 Valve Control Window 12-2
Figure 12-4 Delta Device Services 12-3
Figure 13-1 Calibration Menu 13-1
Figure 13-2 Pressure Controller Setup Diagram 13-2
Figure 13-3 Flow Sensor Zero Window 13-3
Figure 13-4 Pressure Sensor Zero Window 13-5
Figure 13-5 Typical Analog Output Calibration Setup, Voltage 13-6
Figure 13-6 Typical Analog Output Calibration Setup, Current 13-6
Figure 13-7 Analog Output Calibration Window 13-7
Figure 13-8 Analog Output Check Window 13-7
Figure 13-9 Analog Output Cal, Low Point 13-8
Figure 13-10 Analog Output Cal, High Point 13-8
Figure 13-11 Analog Output Cal, Select Analog Output Window 13-9
Figure 13-12 Primary Analog Output Cal Window 13-9
Figure 13-13 Secondary Analog Output Cal Window 13-10
Figure 13-14 : Typical Setup for Calibrating an Analog Input for Voltage 13-11
Figure 13-15 Typical Setup for Calibrating an Analog Input for Current 13-11
Figure 13-16 Analog Input Calibration Window 13-12
Figure 13-17 Analog Input Entry 13-13
Figure 13-18 RT Pressure Sensor Attribute Entry Window 13-13
Figure 13-19 Cal Pages Window, for Flow Devices 13-14
Figure 13-20 Cal Pages Window, for Flow Devices, 13-15
Figure 13-21 Cal Pages Window, for Pressure Devices 13-16
Figure 13-22 Create Default Page Window, for Pressure Devices 13-17
Figure 13-23 Flow Calibration Window (Pre-Cal tab selected) 13-19
Figure 13-24 Flow Calibration, Calibration Tab 13-20
Figure 13-25 Edit Setpoints Window 13-21
Figure 13-26 Calibration Tab, Filled Out 13-22
Figure 13-27 Flow Cal, Meter Setpoint Prompt 13-22
Figure 13-28 Flow Calibration, Linearization Tab 13-23
Figure 13-29 Flow Calibration, Validation Page 13-24
Figure 13-30 Flow Cal, Cert Sheet Preview Page 13-26
Figure 13-31 Flow Cal, Cert Sheet 13-27
Figure 13-32 Valve Tuning Window 13-29
Figure 13-33 Auto Tuning Parameters Window 13-33
Figure 13-34 Auto Tuning In Progress, Course Adjust 13-33
Figure 13-35 Figure 13-34 Auto Tuning In Progress, Cycling 13-34
Figure 13-36 Figure 13-34 Auto Tuning Complete 13-34
Figure 13-37 Flow Valve Tuning Setup Window, SLA Rev A 13-36
Figure 13-38 Flow Valve Tuning Setup Window, Quantim 13-36
Figure 13-39 Flow Valve Tuning Operation 13-37
Figure 13-40 Valve Tuning, Kp Value Is Too High, or Ki Is Too Low 13-38
Figure 13-41 Valve Tuning, Kp and Ki Values Too Low 13-38
Figure 13-42 Original PID Settings 13-39
Figure 13-43 Valve Tuning, Increase Kp Value 13-39
Figure 13-44 Valve Tuning, Overshoot
Figure 13-45 Valve Tuning, Overshoot
Figure 13-46 Pressure Valve Tuning Setup Window (SLA Rev A)
Figure 14-1 Control->Response - Flow
Figure 14-2 Control->Response - Pressure
Figure 14-3 Control->Config-Flow
Figure 14-4 Control->Config-Pressure
Figure 14-5 Device->Device Info
Figure 14-6 Device->Misc Configuration
Figure 14-7 Filters
Figure 14-8 Flow Sensor->Flow Calibration
Figure 14-9 Flow Sensor->Cal Conditions
Figure 14-10 Flow Sensor->TruCal
Figure 14-11 Flow Sensor->Custom
Figure 14-12 Flow Sensor->Zero
Figure 14-13 Flow Sensor->Response
Figure 14-14 Flow Sensor->Corrections
Figure 14-15 Flow Sensor->Scaling
Figure 14-16 Outputs
Figure 14-17 Pressure Sensor
Figure 14-18 Setpoint->Flow
Figure 14-19 Setpoint->Pressure
Figure 14-20 Valve-> Adjust-Flow
Figure 14-21 Valve->Adjust-Pressure
Figure 14-22 Valve->Config-Flow
Figure 14-23 Valve->Config-Pressure
Figure 14-24 Valve->Adaptive Control - Flow
Figure 14-25 "Live" Variables
Figure 15-1 Units of Measure
Figure 15-2 Alarms->Diagnostic
Figure 15-3 Typical Alarm Settings (Density Alarm Shown)
Figure 15-4 Alarms->Configuration (On = Enable, Off = Disable)
Figure 15-5 Control->Response-Flow
Figure 15-6 Control->Config-Flow
Figure 15-7 Device->Device Info
Figure 15-8 HART Protocol
Figure 15-9 Outputs->Primary Output
Figure 15-10 Outputs->Secondary Output
Figure 15-11 Sensor->Zero
Figure 15-12 Sensor->Flow Calibration
Figure 15-13 Sensor->Density Cal
Figure 15-14 Sensor->Status
Figure 15-15 Setpoint->Flow
Figure 15-16 Valve->Adjust - Flow
Figure 15-17 Valve->Config - Flow
Figure 15-18 Valve->Adaptive Control - Flow
Figure 15-19 Variables->Mass Flow
Figure 15-20 Variables->Volumetric Flow
Figure 15-21 Variables->Temperature
Figure 15-22 Variables->Density
Tables

Table 2-1 System Requirements
Table 2-2 Features Requiring a License for SLA Rev A and Quantim Products
Table 2-3 FloCom Minimum Versions Required with BEST 5.2
Table 15-1 Affected by Alarm Disable Options
Chapter 1 Introduction

1.1 Description

The Brooks’ Expert Support Tool is a Windows®-based application that provides expanded monitoring & control of the Brooks’ Digital thermal mass flow controller/meter, pressure controller and remote pressure transducer (RT) models for servicing tasks that include setup, configuration, calibration*, tuning, control, monitoring, and troubleshooting.

BEST 5 is a direct replacement for the obsolete BSS/BST software. BEST 5 adds support for Quantim and SLA Rev A devices. It does not add support for model 4800 devices.

Use of some features requires a Pro software license which is obtainable on a subscription basis. Contact Brooks Instrument to obtain a license. See Table 2-2 for a list of which features require a license.

Note that the Brooks Expert Support Tool is meant to be used as a startup and troubleshooting tool. It is not intended to be permanently connected to the device in your system/application.

Note that this user manual covers only the use of BEST with SLA Rev A (“Legacy”) and Quantim B devices. BEST also supports SLA Rev B (“Enhanced”), PC1xx and VDM300 B devices. Those products are covered by a separate BEST user manual for those products.

Figure 1-1 BEST Main Screen

Note that the Brooks Expert Support Tool is meant to be used as a startup and troubleshooting tool. It is not intended to be permanently connected to the device in your system/application.
1.2 How to Use This Manual

It is recommended that you read the device Installation & Operations Manual (IOM) prior to reading this manual. Read this manual in its entirety before installing or using the Brooks Expert Support Tool.

Note that the illustrations of screens from BEST are illustrative – the exact appearance on your computer screen may vary slightly. Also, if software versions are shown on the figures, your versions may vary slightly.

*Note: For device troubleshooting information, refer to the device’s Installation and Operations Manual.

1.3 Integrated Help

This user manual (which is searchable) can be accessed directly from the software, on the About->User Manual menu item. See Chapter 5.4.

1.4 Theory of Operation

A typical mass flow measurement and control system consists of two components:

- **Mass flow meter.** A mass flow meter incorporates a sensor that measures the amount of mass flow and generates an electrical output signal directly proportional to the mass flow rate.

- **Control valve.**

Mating a control valve with a mass flow meter provides a mass flow controller (MFC).

Implementing a mass flow controller requires using the mass flow output signal as one input and a user-supplied setpoint signal as another input into a comparator circuit. These two signals are then compared and a control signal is generated to operate the opening or closing of the valve. The setpoint signal is, in effect, a request that the mass flow controller maintain a fixed mass flow rate.

BEST, which communicates with the device through an RS-232 connection (or RS232/USB adapter) between the PC and the device’s service port connector, uses a digital signal based on a proprietary protocol. The Service Tool has two operating modes:

- **Indicator**, in which the Service Tool is reporting on the data sent to it from the device, which is being controlled by the normal setpoint source.

- **Control**, in which the Service Tool user specifies the setpoint, overriding the normal setpoint source.

In either arrangement, the device will attempt to manage the opening and closing of the control valve to maintain the amount of mass flow as requested by the setpoint source.

Note that BEST is meant to be used as a startup and troubleshooting tool. It is not intended to be permanently connected to the device in your application.
Chapter 2  Installation

This Chapter describes the system requirements, how to install the BEST application onto a personal computer (PC), and how to connect the PC to the device.

2.1 Hardware Requirements

BEST communicates with Brooks SLA Rev A and Quantim devices via a service port connector that is accessed by removing the device cover (see also Section 2.6.1). This port is connected to the computer via a serial port or a standard USB port. This requires the following cabling as follows:

1.) 3-wire communications cable, Brooks part# S778D023ZZZ
2.) RS232 to TTL communications interface adapter
3.) USB to RS232 communications interface adapter (optional, for USB port connection)

This equipment may be purchased either along with the Brooks Expert Support Tool software or separately from Brooks Instrument. Contact the factory or your local representative for details.

*NOTE:* No “license dongle” is required, but a software license is required for Pro features of BEST.

2.2 System Requirements

This Chapter describes system and software requirements to use the Brooks Expert Support Tool application on a personal computer (PC). The Brooks Expert Support Tool application can be installed on a Windows PC with the following requirements:

<table>
<thead>
<tr>
<th>Component</th>
<th>Minimum Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Microsoft Windows 10&lt;br&gt;Microsoft Windows 8 – BEST has not been formally tested with Windows 8&lt;br&gt;Microsoft Windows 7 – 32-bit/64-bit&lt;br&gt;Microsoft Windows XP, SP3 – 32-bit</td>
</tr>
<tr>
<td>Graphics Resolution</td>
<td>10440 x 990, recommended</td>
</tr>
<tr>
<td>COM Port</td>
<td>One dedicated serial port or USB port</td>
</tr>
<tr>
<td>Software License</td>
<td>Required for Pro Features (Calibration)&lt;br&gt;See table 2.2 below for specifics</td>
</tr>
</tbody>
</table>
Table 2-2 Features Requiring a License for SLA Rev A and Quantim Products

<table>
<thead>
<tr>
<th>Feature</th>
<th>Standard (No license)</th>
<th>PRO License</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Terminal Commands</td>
<td>X</td>
<td>✓</td>
</tr>
<tr>
<td>Device Info</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Model Code Editing*</td>
<td>X</td>
<td>✓</td>
</tr>
<tr>
<td>Dump File</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Wake Up State</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Protocol Settings</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Get Firmware Revision</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Meter Simulate MFC*</td>
<td>X</td>
<td>✓</td>
</tr>
<tr>
<td>Reboot/Power Cycle</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Control Source/Valve Control/Set Point</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Graph/Basic Status/Meters</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Warning Status</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Alarm Status</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Data Logging</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Sensor Zero</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Tuning</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Calibrate input and output signals</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Guided Flow Calibration (SLA Rev A Delta/Smart II only)</td>
<td>X</td>
<td>✓</td>
</tr>
<tr>
<td>Manual Calibration (SLA Rev A Delta only)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Graph Settings</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Warning Settings</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Alarm Settings</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Calculators</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

*Not supported for Quantim

2.3 Installing the Brooks Expert Support Tool Application

This Chapter describes how to install the Brooks Expert Support Tool application onto a personal computer (PC).

Uninstallation of existing versions of BEST prior to installation is not required, but recommended. See Chapter 2.4 for more details about uninstallation.

Versions of BEST above 4.0.0.0 can co-exist with versions below 4.0.0.0.

To install the Brooks Expert Support Tool application, download the BEST installer file from the Products/Software Chapter of the Brooks Instrument website (www.brooksinstrument.com). Once the installation file is downloaded, decompress if necessary.
Before installing, open and read the Readme file for last-minute updates and helpful notes that may not be included in this user manual.

Before starting the BEST installer, it is recommended to disconnect or power down any mass flow devices connected to the computer’s serial ports or USB ports.

Run the setup.exe file - it is recommended to run this file as an administrator. Right click on the file and a pop-up menu appears. (See Figure 2-1). Click “Run as administrator.”

![Figure 2-1 Running Setup.exe as an Admin](image)

Next, follow the installation instructions provided by the software. It is recommended to install BEST and its components in the default folders provided by the installer.

The installer will install BEST and its required software components, including versions of FloCom, FloComPlus and the FloCom databases.

For users who require a specific version of the FloCom database component, during the installation, the user will be presented with a software component selection menu (See Figure 2-5). Uncheck the item FloCom Databases to preserve the currently installed version/not install the version from the installer.

*NOTE: BEST requires certain versions of FloCom and the FloCom database be installed. If you do not install the database version from the installer you must ensure that the desired version of FloCom database is installed separately from the BEST installer.

<table>
<thead>
<tr>
<th>Program</th>
<th>Required Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>FloCom</td>
<td>4.16</td>
</tr>
<tr>
<td>FloComPlus</td>
<td>1.40</td>
</tr>
</tbody>
</table>

Table 2-3 FloCom Minimum Versions Required with BEST 5.4
2.4 License Installation

To obtain a license, the user must contact Brooks Instrument to obtain a yearly license subscription. The user will receive a license key (a number), then enter it in the License Key text block.

*NOTE: After receiving your license key, store it in a safe location (backed up and secure from unauthorized use) for later retrieval.
Normally, the license installation process requires an Internet connection. A license can be installed without an Internet connection – contact Brooks Instrument for details.

To install a license, click on the menu Help->License->Install License. The window in the figure below will appear.

![Figure 2-3 License Installation Window](image)

Copy and paste your license key text into the License Key text box. Then click Install. The software will attempt to use an Internet connection to contact Brooks Instrument to verify the license. Then the license will be installed on the local computer. You will receive a message when it is finished. To view the installed license, click the menu item Help->License->Info. See also Section 5.2.

![Figure 2-4 License Information Window](image)
2.5 Uninstalling the Brooks Expert Support Tool Application

To uninstall BEST, go to the Windows Control Panel -> Programs and Features. Look for any items entitled "Brooks Expert Support Tool". Right click the item and select Uninstall. Follow the onscreen instructions.

Repeat for any items with the title “Brooks Expert Support Tool”.

*NOTE: The uninstallation does not uninstall any of the auxiliary components such as FloCom or FloCom databases, installed with BEST. These do not necessarily need to be uninstalled, but to uninstall, repeat the above paragraph for the items “FloCom”, “FcPlus”, etc.

2.6 Connecting the PC to the Device

The following Chapter describes the procedure for connecting the PC running BEST to the device’s service port, for both the SLA Rev A and Quantim devices.
2.6.1 Connection Hardware Requirements

The following tools and cables are required to connect the PC serial port to the device's service port:

- 3-wire communications cable (between the interface connector and the device's service port connector)
  - Brooks part# S778D023ZZZ
- RS-232 to TTL communications interface adapter.
- USB to RS-232 to TTL communications interface adapter (optional for use with USB port)
- Phillips head screwdriver

![Figure 2-5 3-Wire Communications Cable and Adapter](image-url)
2.6.2 Connection Procedure

**CAUTION**

The electronics within this device are Electrostatic Discharge (ESD) sensitive. Be sure to follow proper ESD precautions at all times while the service port connector is exposed. The unit chassis should be adequately grounded. The operator should also be grounded (via wrist/ankle strap) when contacting the device while the service port is exposed. Failure to follow these precautions may void your device warranty.

To connect the PC to the device’s service port:
1. Turn off power to the device.
2. Remove the standard cable from the device’s 15-pin D-connector.
3. Remove screws from the top cover.
4. Remove the cover.

5. Connect the 3-wire communications cable to the device’s service port, the black connector located behind the D-connector. Align the communications cable’s 5-pin connector with the **black wire** towards the **center** of the device (towards the LEDs), as shown in the following illustration.
6. Connect the RS232 to TTL communications adapter to the D-Connector of the 3-wire communications cable. Make sure to connect the end labeled TTL to the cable.

7. If you are using your PC’s serial port, connect the RS232 to TTL adapter directly to a serial port on your computer. Make sure to connect the end labeled RS232 to the serial port.

8. If you are using your PC’s USB port, connect the USB to RS232 communications adapter’s D-connector to the RS232 to TTL adapter’s end labeled RS232. Then connect the other end of the USB to RS232 adapter to the computer’s USB port.

9. Reconnect the standard cable to the device’s D-connector. This connection is used to apply power and the analog setpoint to the device while using the Service Tool.

10. Turn on power to the device.
### 2.6.3 Disconnecting the PC from the Device

When you are done using the Service Suite, you should disconnect the PC from the device and reinstall the device’s cover.

To disconnect the PC from the device’s service port:

1. Detach from the device using BEST.
2. Exit from BEST software, optionally.
3. Turn off power to the device.
4. Disconnect the standard cable and the 3-wire communications cable from the device.
5. Disconnect the interface adapter from your PC.
6. Place the cover onto the device, and reattach it using the screws.
7. Reconnect the standard cable to the device’s 15-pin D-connector.

You can now reapply power to the device and begin using it in a process application.
Chapter 3  Basic Operations

This Chapter gives a general introduction to the basic operation of BEST, including starting BEST, the main screen, establishing communications with a device, viewing the main graph window, detaching from a device, and the menus.

3.1  Main Screen

To start BEST, select BEST from your Start menu, or double-click its application shortcut. The main window displays, with no devices connected.

The Title Bar shows the name and current version of the software. The title bar can also be used to select, move, and maximize the window, according to Windows conventions.

The Menu Bar is where most functionality of BEST is accessed. BEST windows are opened from the menu bar. Menu items are typically accessed from left to right and top to bottom.

The BEST desktop is where all opened BEST windows exist. This is similar to the Windows desktop, except that this desktop contains only BEST windows. See also Chapter 6.

The Status Bar shows useful instructions and messages about the current status of the software and its processes.

If the user is using dual monitors, the user may gain additional space for windows by dragging the edge of main screen across to the additional monitor.
When the software first starts, it shows the device connection window in the center of the Window Background. To use most features of BEST, you must first "attach" (or establish communication with) a device using the connection window. See Chapter 9.1.1 for more details about the Connection Window.
3.2 Attaching to a Device

The first thing you will want to do is to establish communications with (or attach to) a device.

When BEST software starts, no devices are attached. Devices are attached via the device connection window. For convenience, the software opens the device connection window for you upon startup.

First, in the Device Connection/Port drop-down list (See Figure 3-2), select the COM Port you are using to connect to your device.

Next, select the desired Baud rate from the Device Connection/Baud rate drop-down list. Most users will choose optimize, which will automatically select the fastest baud rate that successfully communicates with the device. If you have trouble attaching to a device, you can try a lower baud rate to troubleshoot. Your selected port and baud rate selections will be retained by BEST for your convenience.

Click the Next > 1 Device button to find the connected MAC address. After a few moments, if a device is located, its MAC ID (or “address”) is listed in the Mac ID drop-down list.

Once a device’s MAC address is located, click on the Attach button. After a few moments, if it is attached, a row appears in the connected devices box, as shown in the Figure below.

Figure 3-2 Device Connection Window, Device Attached

If a device has DeviceNet, Ethercat, or FieldBus, a window will pop up asking if you want to place the device in the executing state.
If you need to control the device’s setpoint with BEST, click Yes. Once the device is attached, close the Device Connection window. Likewise, when detaching from a device, it may ask you if you want place the device in the idle state.

See also Section 10.1.1 for more details about device connections.

### 3.3 Main Graph

Once a device is attached, you can run the main graph to watch the behavior of the device. Click on the green button in the upper left corner of the Devices Connected block. The main graph window will open, then Click Start.

See Chapter 8.4 for more details about the graph window.
3.4 Closing the Session with the Device and Exiting BEST

To close the communication session with a device and exit the software, open the File menu and choose Exit, or click the window’s close button (the X in the upper right corner). Exiting the software automatically closes all communications with the device.

Alternatively, the user may close the communications with (or “detach” from) the device, by opening the Device Comm->Connection menu. Then click Detach. The user may attach to another device, if desired.

3.5 Brooks Expert Support Tool Conventions

The Brooks Expert Support Tool was designed to remain consistent with regard to how the user interacts with the application across all functions and features. It is also generally consistent with Windows user interface conventions.

The following text field conventions apply throughout the software:

Text fields with a gray background display a read-only value (such as the Current Position (%) in Figure 3-6 below).

Text fields with a white background are editable (such as Set Valve Position (%) in Figure 3-6 below).

Usually, editable text fields update the software or device either when the user clicks the Enter button, when the focus moves to another field by using the Tab key or mouse, or when a separate apply button is clicked (see each Chapter in the manual for specific instructions).

If a text box contains “NaN” or “n. def.” it means “Not a Number”, not defined, or invalid calculation result.

Many windows also require numeric input from the user. This type of window is also called a “form”. For numeric input, forms often feature numeric up/down controls. See Figure 3-6 below for an example of a numeric up/down control (circled).

Figure 3-6 Example Numeric Up/Down Control

Up/down controls help prevent invalid numeric data entry. Click the up arrow to increment the numeric value, or the down arrow to decrement. Up/down controls also have maximum and minimum values. You may also type in a number directly, but it won’t allow non-numeric entry. Also, in some cases, it won’t accept a thousands separator character (for example, “,” in English culture). In most forms, you may also click enter to accept the entered value, or move the focus off the control to another control on the form.
Data Entry and International Locales: While BEST doesn’t translate all words from the English language, BEST supports various number and date formats for data entry and display, according to the user’s computer settings for that region (see Control Panel->Region and Language on your computer). BEST uses the user’s Windows settings for region and locale for most numeric data, except where noted in this manual. For example, when entering a decimal number in English a user might type 1.234 into a text box, but for German culture, one must enter 1,234 because in that culture the comma is the decimal separator.

*NOTE: In some BEST windows you must always enter English formatted numbers. For example, in the terminal window, you must use English decimal number formats because the commands that a device accepts require English. In those types of windows, a statement will be present on the form as a reminder.

For most windows in BEST, for data entry, you must use the format of your region, except where noted in this manual. Likewise, most windows will display numbers in the format of your region, except where noted in this manual.

The sample illustrations in this manual are shown using the English region formatting.

3.6 Menu Bar

The Menu Bar (see Figure 3-1) is where most functionality of BEST is accessed. BEST windows are opened from the menu bar, and then those windows will exist on the BEST Desktop. Menu items are typically accessed from left to right and top to bottom.

Note that this manual shows all menu items. Certain menus may not appear if the features of those menus are not supported by the currently selected device.

Subsequent chapters of this manual describe each of the menus in detail.
Chapter 4 File Menu

The File Menu Item contains a place to exit the program. See Figure 4-1 below. (You may also exit the program via the “X” in the upper right of the title bar, according to Windows convention).

Figure 4-1 File->Exit Menu
Chapter 5  Help Menu Item

The Help Menu Item is where information about the BEST software can be accessed, including the current version of BEST, licensing options, and user help. A device connection is not required to access these menu items.

![Help Menu](image1)

Figure 5-1 Help Menu

5.1 About Window

The About -> About Menu Item is where information about the current version of BEST and its software components can be viewed. Information provided includes the current version of BEST and its software components. (The current version of BEST is also always visible in the main screen’s title bar.)

![About Window](image2)

Figure 5-2 About Window  
(Your versions may vary)
5.1.1 License Info Window

The License Info Menu Item is where information about installed licenses for the current version of BEST can be viewed (but not updated). The user may also set options about when to be reminded of license expiration.

Figure 5-3 License Information Window (Your versions may vary)

5.1.2 Install License Window

The Install License Menu Item is where licenses may be installed (and uninstalled). To obtain a license, the user must contact Brooks Instrument to obtain an annual license subscription. The user will receive a license key (a number), then enter it in the License Key text block.

*NOTE: After receiving your license key, store it in a safe location (backed up and secure from unauthorized use) for later retrieval.

Normally, the license installation process requires an Internet connection. A license can be installed without an Internet connection – contact Brooks Instrument for details.
5.1.3 EULA Window

The EULA is where the user may view the End User License Agreement (EULA).

5.2 User Manual Menu

This manual (which is searchable) can be accessible directly from the software under the About->Help menu. A PDF file reader (such as Adobe Reader) must be installed on the computer to read this file.

5.3 ReadMe Menu

The user may view last-minute updates as well as technical and useful troubleshooting information from this menu.
Chapter 6  Window Menu

The **Window Menu Item** is where BEST windows can be accessed and controlled.

A note about BEST Windows and the BEST desktop: BEST windows exist on the BEST desktop (see Figure 3-1). This is similar to the Windows desktop, except that the BEST desktop contains only BEST windows.

BEST windows are sized and closed in a similar way as in the Windows. Most BEST windows can be sized, minimized, maximized, restored. Some BEST windows have minimum and/or maximum sizes. Multiple windows may be opened with some exceptions. Some windows, such as calibration windows, when they are open, do not allow access to other windows until they are first closed. (These are called “modal” windows). A modal window cannot be minimized or maximized, but may be resized by dragging the sizing handle in the lower right corner of the window (if the window is not maximized).

Note also that the title bar of each BEST window shows the serial number of the device associated with that window.

If any windows are open in the BEST desktop, they will be listed in the Window menu under the Arrange (See Fig. 6-1). Clicking one of those menu items will activate that window.

![Figure 6-1 Window Menu](image)

The **Close All** Window menu item closes all windows (for all devices).

The **Cascade** Window menu item, arranges all open windows in a “cascade” arrangement from the upper left corner of the windows. See Figure 6-2 below.
Figure 6-2 Cascaded Window Layout

**Tile** will arrange all open windows in a “tile” arrangement. See Figure 6-3 below.

Figure 6-3 Tiled Window Layout

**Minimize All** minimizes all windows to an icon representation. See Figure 6-5 below.

*NOTE:* If a modal window is minimized, it will disappear into an icon at the bottom of the screen. To restore it, click on the icon.
Figure 6-4 Minimized Windows
Chapter 7  Settings

The **Settings Menu Item** is where BEST software options can be changed to the user’s preferences. These are software options, not device options. Most of the features in this menu do not require a device connection.

![Settings Menu](image1)

**Figure 7-1 Settings Menu**

### 7.1 Graph Options

The **Graph Options** is where the user can select options and preferences for the operation of the main graph window. Here the user can select the data units, scaling, and graph legend options. See Figure 7-2 for the Graph Options window.

![Graph Options](image2)

**Figure 7-2 Graph Options Window**

For each graph parameter (flow, pressure, temperature, etc.), the user can choose which parameters to show on the graph, legend, and meters panel (See Section 8.4 for more information on the meters panel of the main graph window).
The user can also choose to allow the software to determine which parameters to show automatically by choosing to select **Auto Show Default Parameters**, in which case the software will show only the parameters relevant for the device type (for example, an MFC device will not show pressure or pressure setpoint). If **Auto Show Default Parameters** is checked, the individual parameters’ **Show on Graph** check boxes will be disabled – if it is unchecked they will be enabled. For most usages, leave Auto Show Default Parameters checked.

*NOTE:* If you need a higher data sample rate, such as with response tuning, uncheck the **Auto Show Default Parameters** check box and select only the parameters you need to view. Unchecking the Valve Position parameter can yield significant increases in sample rate.

For each parameter, the user can choose “device units” in which case the units stored in the device are automatically chosen for display.

The graph Y axis scaling for both the left side Y axis and the right side Y axis can adjusted by the user. The left side axis is for flow, flow setpoint, pressure, and pressure setpoint. The right side axis is for valve position, valve current, temperature, and density.

The **Num Dec Places** block sets the number of decimal places displayed for flow and pressure across the software.

Valve current is for VDM300 devices only.

*NOTE:* For some parameters, changing graph settings while the graph is running may require the graph to be closed and re-opened for the changes to take effect.

### 7.2 Reset All User Options

Reset All User Options is where the user can reset all BEST software user settings to their factory default settings. Use with caution.

### 7.3 Data Logging Options

The **Data Logging Options Menu Item** is where the user can set preferences as to whether data from the main graph window is to be saved to file as it monitors. Check the check box **Save Data To Log** to save data to file. Files can be saved in either text or csv format. The file name will be created automatically. The folder is listed in the Data Log File Path text box. The user can also conveniently open saved files from the path by clicking a single button, the **Open File** button. See Figure 7-3 for the Data logging options window.

The data logging status (on or off) is shown at the bottom of the main graph window.

The user may also have some control over the sample rate (of both the graphical display and the recorded data). Under the units drop-down, select Maximum to obtain the maximum sample rate on your system. Otherwise, select SamplesPerSecond or SecondsPerSample, then set the Target rate. The target rate is not a guaranteed rate, nor is the rate guaranteed to be precise.
7.4 User Totalizer Options

The **User Totalizer Options Menu Item** is where the user can set preferences for the user totalizer for devices that support a totalizer. (NOTE: the user totalizer is different than the device’s hardware totalizer. See Section 13.4 for details on the hardware totalizer and Section 13.3 for more details on the user totalizer). The user can set preferences as to how often to update the user totalizer window and can reset the user totalizer. See Figure 7-4. The user totalizer units are always the same as the device’s setting for totalizer units.

A device must be attached to use this window.
Chapter 8  Monitoring Menu

The Monitoring menu gives the user the ability to monitor various aspects of the device. Each of the windows accessible through the Monitoring menu, when opened, shows a live status of various parameters of the device. This includes alarms, warnings, flow, pressure, control, and other status parameters.

A detailed description of the main graph window is given in Section 8.4.

![Monitoring Menu](image)

Figure 8-1 Monitoring Menu (not all devices support all menus)

Except for the graph window (Section 8.4), these windows are monitoring if they are open. These windows update typically at about once per second. These windows are read-only windows and can access and display these parameters whether the device is in digital or analog control mode.

Most Monitoring menu windows can be resized by using the mouse to grab an edge or corner of the window and dragging.

8.1  Warning Status

For SLA Rev A and Quantim devices, the warning status is integrated with the alarm status window. See Section 8-2 for a detailed description of warning status monitoring features.

8.2  Alarm Status

The Alarm Status window shows detailed alarm and warning status for various alarms. The screen is updated about once per second. An alarm is indicated by a red square, a warning is indicated by a yellow square, and a normal condition is indicated by a green square. The Flash Code is the number of times the red LED on the devices flashes to indicate an alarm. Clicking the clear button will clear any latched alarms.

The alarm status window can be resized by dragging a corner or edge of the window.

The exact alarms and warnings supported/visible may vary depending on the device type and alarm settings. Alarm settings are described in Section 11.7. Alarm Status is only supported for Delta Lite Smart II devices and Quantim devices.
Figure 8-2 Alarm Status Window, Delta Lite/Smart II Device
(Note: exact alarms visible may depend upon device type)

Figure 8-3 Alarm Status Window, Quantim Device
(Note: exact alarms visible may depend upon device type)
8.3 User Totalizer Window

The User Totalizer allows a user to track to total flow of a device over time form a user reference point in time. The User Totalizer is only supported if the device supports a hardware flow totalizer.

*NOTE: The User Totalizer is different from the hardware totalizer. The hardware totalizer is a totalizer that exists in the device firmware. The hardware totalizer cannot be reset, as it is for maintenance purposes. The user totalizer, however, is based on the hardware totalizer. The User Totalizer may be reset by clicking the Reset button in the window. The window’s update rate and flow units displayed may be set by the user (See Section 7.4). The window shows the total elapsed time since the last reset. The User Totalizer window is shown in Figure 8-4.

User totalizer options are set via the User Totalizer options (see Section 7.4).

![User Totalizer Window](image)

8.4 Graph Window

The Main Graph window shows device measurements such as flow, flow set point, pressure, pressure set point, temperature, and valve position, over time. It also features some commonly used control functions.

![Main Graph Window](image)

When the main Graph window is opened it does not start monitoring automatically. To start monitoring, click the Start button. Click Stop to stop monitoring. Click Start to re-start, or Resume to resume monitoring.
There are a number of options of the graph that the user can select. They can be selected in the Tools->Options->Graph menu (See Section 7.1).

The parameters that are graphed on the window, the units used for the parameters, X scale, Y scale, and legend are all user options.

The left side Y axis is for flow, flow setpoint, pressure, and pressure setpoint. The right side Y axis is for valve position, valve current, temperature, and density.

The Meters Panel shows important device measurements. (The name “meters” was chosen because a flow meter measures flow, a temperature meter measures temperature, etc.). The exact parameters that are shown may change depending on the user graph settings and the type of device (See Section 7.1). The Meters Panel is also where the user selects the control source and set point.

The Control Source can be either Digital (BEST Software) or Analog (External) for control of the set point. If the control source is set to digital, the user controls the set point via BEST software via the diagnostics port (see Section Set Point control below). If analog is selected, the software no longer controls the set point, (but can still monitor the set points) – the set point is control by an external controller physically connected to the device on its normal control port (and not via the Diagnostics port).

Selecting analog disables BEST software’s set point up/down control. Selecting digital control re-enables it. Changing the Control Source from analog to digital will cause the software to change the device’s set point to 0 for safety.

The Set Point Control allows the user to set the device’s set point via BEST software (if Control Source is set to digital). The units for the set point are displayed next to the numeric up/down control. These units are the same as set by the graph options for set point (flow or pressure set point depending on the type of device - see Section 7.1). If the user changes the units options under the graph options menu, the units here will be updated to match and the numeric value will be updated to the equivalent units.

The Basic Status Panel shows some basic status parameters. The displayed parameters are:

Monitoring: Whether the main graph is currently Running or Stopped.

Full Scale: Displays the full scale flow or pressure range of the active device (value and units).

Communication: Will show “Active” or the last error message, if any.

Alarm: Will show “Alarm”, “Warning” or “Normal”. Alarm will show if any alarm is active. To see which alarm is occurring, open the Alarm Status window (See Section 8.3). If there is no alarm, but a warning is occurring, this will show “Warning”. To see which warning is occurring, open the Alarm Status window (See Section 8.1).


Control Source: Analog or Digital.

Flow Totalizer: The value of the hardware totalizer (See also Section 8.4).

Data Logging: On Or Off.
Totalizer: The value of the hardware totalizer

There is a user **Text Annotation** block that can be used for labeling purposes. The text can be edited, moved, and resized. To edit the text block, click on the text block, type in the new text, then click off the block. To move the text block, click on the text block and a frame will appear - then drag the box to the desired location. To resize the text block, click on the text block and a frame will appear – then drag one of the handles (sides or corners). To clear the text, select the text and edit it to an empty text string. If the text is hidden, click Find Annot. Double click the text box to edit the text.

**Screen Capture**: The graph can be saved to a graphics file by clicking Capture. Supported graphics file format are jpg, bmp, gif, png, and tiff.

**CAUTION**: The default file path for the capture file after installing or updating BEST will be set to a subfolder of the BEST folder. **After installing or updating BEST, these folder path should be changed to a folder on your personal computer or network (preferably on a backed-up folder location).**

**Print Screen**: The graph can also be printed. Click Print.

**Cursor**: The user can display a cursor on the graph. A cursor is cross-hair that can pin point a location on the graph. To activate a cursor, click anywhere on the graph with the mouse. A crosshair appears and in the lower right corner of the graph, a box appears with the X and Y location of the cursor (See Figure 8-6). To move the cursor click on another location in the graph and the location of the cursor is updated in the box. To remove the cursor, right click on the graph. A context menu appears – click Clear Cursor (See Figure 8-7).
Zoom: The user can zoom in on a portion of the graph. To zoom in, click anywhere on the graph with the mouse, then drag to form a rectangle, then release the mouse. The graph shows a zoomed area of the graph and scroll bars appear (see Figure 8-8). To remove the zoom effect, right click on the graph. A context menu appears – click reset Graph Zoom (see Figure 8-7).

NOTE: For some parameters, changing graph settings while the graph is running may require the graph to be closed and reopened for the changes to take effect.
Chapter 9  Tools Menu

The Tools Menu Item is where some convenient utility tools can be accessed. Most of the features in this menu do not require a device connection.

Figure 9-1 Tools Menu

9.1  Pressure Units Calculator

The Pressure Units Calculator Menu Item opens a convenient utility that can convert a pressure value from one unit to another.

Figure 9-2 Pressure Units Calculator

9.2  Flow Units Calculator

The Flow Units Calculator Menu Item opens a convenient utility that can convert a flow value from one unit to another. The user can optionally factor into the conversion the reference temperature, and pressure. Conversions involving mass-based units require a gas symbol in both drop-down controls.
9.3 Temperature Units Calculator

The Temperature Units Calculator Menu Item opens a convenient utility which can convert a temperature value from one unit to another.

9.4 Density Units Calculator

The Density Units Calculator Menu Item opens a convenient utility that can convert a pressure value from one unit to another. Lookup Gas Density will calculate and show the density of the gas based on the reference temperature and pressure using the FloCom gas database.
Figure 9-5 Density Units Calculator
Chapter 10 Device Comm Menu

The **Device Comm Menu Item** is where BEST software performs communication tasks with a device. The **Connection** menu item establishes communication with a device. The **Terminal** menu item provides low-level communication (sending commands) with a device.

![Device Connection Menu](image1)

**Figure 10-1 Device Connection Menu**

### 10.1 Device Connection Window

![Device Connection Window](image2)

**Figure 10-2 Device Connection Window, with No Devices Attached**

Most features of BEST software require a connection to a device. If you attempt to access a feature that requires a device connection and you are not connected to a device, you will see a message box like the following:
When BEST software starts, no devices are attached. Devices are attached via the device connection window. For convenience, the software opens the device connection window for you upon startup. You can close this window if you wish. If it is closed, you may re-open the window via the Device Comm->Connection menu or the Connection button in the devices panel (See Figure 3-2).

For Rev A and Quantim devices, BEST supports only one device connected at a time on a given COM port. The Next >> All Devices button and BaudRate drop-down controls are not used for Rev A and Quantim devices.

First, in the Device Connection/Port drop-down list (See Figure 10-2), select the COM Port you are using to connect to your device.

Your selected port selection will be retained by BEST for your convenience.

Click the Next > 1 Device button to find the connected device. After a few moments, if a device is located, MAC ID 0 is listed in the Mac ID drop-down list.

Click on the Attach button. After a few moments, if it is attached, a row appears in the connected devices box, as shown in Figure 10-4.
Device Type Codes

In the Connected Devices box, under the Dev Type field, the possible values are:

- MFC Mass Flow Controller
- MFM Mass Flow Meter
- PC Pressure Controller
- RT Remote Transducer Device

Attaching Multiple Devices Simultaneously:

BEST supports connecting to multiple devices simultaneously. There are two methods of doing this:

1.) Connecting devices to a single COM ports.
2.) Connecting using multiple COM ports.

Connecting multiple devices to BEST requires a custom splitter cable between a single COM port on the computer and multiple devices. (This type of cable is not supplied by Brooks Instrument).

When using SLA Rev A or Quantim devices, only one device may be connected to a given COM port at a time. However, you may attach both SLA Rev A/Quantim devices and RS485 devices, if the FloCom and non-FloCom devices are on separate COM ports.

*NOTE: You may not attach both FloCom and non-FloCom devices on the same COM port (FloCom devices are SLA Rev B, PC1xx, and VDM300 devices. Non-FloCom devices are SLA Rev A, and Quantim devices.).

(see the BEST manual for SLA Rev B, PC1xx, VDM300 devices.)
**Detaching a Device:**
To detach a device, make sure that device is selected as the active device (by the blue highlight bar), then click the Detach button. The device will be removed from the Connected Devices list and from the devices panel. This will also close any windows open for that device.

*NOTE:* clicking the Detach button detaches the device highlighted in blue in the Connected Device list, NOT the device select in the Mac ID drop-down box.

*NOTE:* If you change physical connections to the device or computer while the software is running, you may need to exit the software and restart it for it to recognize the new connection.

You may close the Device Connection window with the Close button or clicking the “X” in the upper right of the Device Connection window’s title bar.

When you exit the BEST program, all devices are detached automatically.

**10.1.1 Connecting to an Unconfigured Device**
BEST can be used to attach to and set up devices (and “blank” boards) that have not yet been configured, or have an invalid/unsupported model code attribute. If you try to attach to such a device, and BEST does not recognize the device’s model code, it will display the Fix Model Code window (see Figure 10-5).

![Figure 10-5 Fix Model Code Window](image)

The Fix Model Code window gives the user an opportunity to fix or set up the model code. The user may fix the model code in one of two ways, as explained below.

The Device Configuration Code text box shows the current model code of the device. The user must select the Desired Device Type (SLA = SLA Rev B). Then they may use either method below.

1. Manually type in the model code, if the user knows the correctly formatted model code, then validate the code.
2. Set the model code to a default value, then use the model code window to set up the individual fields of the model code. This is the preferred method.

*NOTE:* The model window is not editable for SLA Rev A and Quantim devices. So, the correct full model number would need to be entered at the fix model code window.

To use method 1:

1. Select the Desired Device Type.
2. Manually type in the model code.
3. Click Validate. If the validation is bad, check the model code, re-type, and try again.
4. Click Change.
5. The status bar will inform you if the change was successfully applied.

To use method 2:

1. Select the Desired Device Type.
2. Click Default. The default model code for the selected device type will be shown in the Device Configuration Code text box.
3. Click Change.
4. The status bar will inform you if the change was successfully applied.
5. Close the Fix Model Code window.
6. Open the Model Code window (under the Device Config->Model Code menu) (See section 11.3), and set the fields to match your device’s hardware.

After setting the model code correctly, the user should continue setting up other attributes as necessary.

### 10.2 Terminal Window (License Feature)

The Terminal provides low level communication access with a device. A connection to a device is required for this feature. This feature is for advanced users. A software license is required for this feature.

*NOTE:* All numeric or date information entered this window must be in English culture format. Likewise, any numeric or data information displayed in this window are in English culture format.

Unlike for SLA RevA/PC1xx/VDM300 devices, commands are typed in as numbers, not names, as shown below.
Figure 10-6 Terminal Window
Chapter 11 Device Config Menu

The **Device Config** Menu provides functionality to help a user configure a device with settings such as model code, control mode, alarm settings, and protocol settings. Access to individual settings is device and license specific. Functions that are not supported for a particular device will not be visible.

A device connection is required to use most of the config functions. Also, for some menu functions, if device control source is set to external control, the software may first ask if the user wants to set control to digital/BEST control (required for most config functions).
11.1 Dump Files

BEST software allows the user to save and reload a complete set of settings for a device in a file. Access to this feature may be dependent upon device type and software license level. This type of file is called a dump file.

NOTE: It is strongly recommended that when you first receive a new device, to immediately save the settings in a dumpfile as a backup for future reference.

BEST dump files are saved in an encrypted format. Quantim and SLA Rev A Delta class devices use *.dat format. SLA Rev A DeltaLite/Smart II devices use *.cal format. (Both formats are encrypted).
File names are coded using the device serial number.

When the Dump File window opens, it shows a coded dump file name for the current device serial number and selected dumpfile type. To select a different file name, edit the file name/path, or select a new file by clicking Select File.

To save a dump file, first select a file type under the Save File block, then click Save File. If a file already exists, saving a file again will not overwrite any existing file. It may take a few minutes to complete the save operation.

For some older devices (SLA Rev A devices with firmware rev. <= AE), when saving a dumpfile, the user will see an additional screen to select which pages they want to save in the file.

An existing dumpfile may be used to reload settings into a device. The file path of the last used dumpfile path is displayed in the File Path text box on the form. To change the file click, click Select File or type in the file path directly.

*NOTE:* Take caution to load only a dumpfile specified for the current device (same serial number). Prior to loading a dumpfile, the software will check the serial number of the device and compare it to the serial number in the dumpfile. If they don’t match, a warning will be displayed. It is STRONGLY recommended that you do NOT ignore this warning.

To reload a dumpfile, first select a file by clicking the Select File button. Then click Load File. A series of warnings will be displayed. A reload may take a minute or two. After reloading, the device will be automatically rebooted if the device supports rebooting. Then, the results text box will show any attributes from the dumpfile that were not able to be loaded. It is not unusual for a few attributes from the file to fail to load.
11.2 Device Info

The **Device Info** menu item allows a user to view selected information about a connected device. This window is read-only. Some fields may appear as blank if the device does not support an attribute.

![Device Info Window](image)

Figure 11-7 Device Info Window

( the selected information shown may vary depending on device type)

11.3 Model Code Window

The model code window allows the user to view (and edit with a license) the device’s model code. The model code is read-only for Quantim devices. The model code (also called the Product Data Code or “PDC”) is stored in a device and identifies the type and options of a device. The model code is a formatted string of characters with coded fields representing various device options.

Viewing the model code can provide key information for the user about a device. The model code window can assist the user in decoding the fields.

![Model Code Window](image)

Figure 11-8 Model Code Window
11.4 Protocol Settings Window

The Protocol Settings menu only applies to the Quantim device. This menu takes the user to another screen for setting the parameters for the Hart protocol used by the Quantim device. See Section 15.5 for more details.

11.5 RT Control Mode

The RT Control Mode window is used to change the current control mode of an RT device between Flow control and Pressure control modes. This window is only available for SLA Rev A RT devices.

*NOTE*: the changes won’t be applied unless the user clicks Change.

![RT Control Mode Window](image)

Changing the Control mode will require a device reboot for the change to take effect. The software will prompt and guide the user to do a reboot.

11.6 Meter Simulate MFC (License Feature)

The Meter Simulate MFC window is used to allow a meter device to simulate an MFC device. This mode is needed for specific calibration situations, such as when calibrating a meter device using a temporary external valve directly connected to a meter device’s electronics.

A license is required for the use of this feature. This feature is supported only for SLA devices.

There are two ways of calibrating an SLA meter device using BEST:
1. **Using the valve output of the meter.** Since the meter version of Brooks SLA products contains the same electronics circuitry as the controller version, it’s possible to connect a standalone valve or a compatible valve from a Brooks SLA controller to the valve output of the electronics circuitry. If the Meter Simulate MFC window is used, the meter device will act as a controller and can be calibrated just like with any MFC controller. After calibration, the device type needs to be configured back to MFM. Note that this valve connected to the meter needs to be in the flow path during calibration (see also section 13.11 for full calibration instructions).

2. **Using an external valve.** In case it’s not possible to connect a standalone valve or a compatible valve from a Brooks SLA controller to the valve output of the electronics circuitry, it’s possible to put an external valve in the flow path and regulate flow using this external valve. Note that the device type needs to be configured to MFM. During the calibration, the user will be prompted to manually adjust the flow indicated in the pop-up window (see Figure 13.27), to a certain percentage by using the external valve (see also section 13.11 for full calibration instructions).

   ![Figure 11-10 Meter Simulate MFC Window](image)

To use this feature on meter device:

1. Click the menu item Device Config->Meter Simulate MFC.
2. Click MFC.
3. Perform calibration as with an MFC device.
4. Click the menu item Device Config->Meter Simulate MFC.
5. Click MFM.

*NOTE:* Changing the device type with this feature will also change the model code and other attributes accordingly, so remember to change this back to MFM device type when finished.
11.7 Alarm Settings

The software supports configuration of warnings and/or alarms for the device. The exact alarm and warning settings supported depends on the device. Pressure-related warnings and alarms, for example, will only be supported by the PC and RT models. Configurable alarm settings typically include alarm/warning/off, latching enable, contact enable, limits, and delay time. If the device supports flash codes, the ALARM LED will flash the specified number of times if a certain alarm or warning is raised.

For more specific information on alarms and warnings, reference the specific device installation & operations manual and/or supplemental manuals for your device type.

For the SLA Rev A/Delta Lite/Smart II class devices, alarm windows are shown in Figures 11-11 and 11-12.

For the SLA Rev A Delta Class, alarms are not configurable via BEST.

For the Quantim device, this menu opens the alarm settings window described in Section 15.2 (see that section for more details).

Figure 11-11 Alarm Settings, SLA Rev A/Delta Lite/Smart II Class Devices
11.8 Config Parameters

The **Config Parameters** is where various configuration parameters are viewed and changed for some device types (for Quantim and SLA Rev A Delta Class devices, but not for SLA Rev A Smart/DeltaLite). The exact tabs and parameters that are visible depends on the device type.

For SLA Rev A Delta Class devices, see Chapter 14.

For Quantim devices, see Chapter 15.
Chapter 12 Device Control Menu

The **Device Control** menu provides functionality to control a device with functions such as valve control, and rebooting a device. Menu items visible may vary depending on device type.

![Device Control Menu](image)

**Figure 12-1 Device Control Menu**

### 12.1 Reboot Device

This window will allow a user to reboot a device. A reboot is similar to cycling the power to the device. If the user clicks reset, and confirms, the device will be reset and the device will remain attached to the software.

Quantim devices do not support Reboot Device.

![Reboot Device Window](image)

**Figure 12-2 Reboot Device Window**

### 12.2 Valve Control

The **Valve Control** menu provides functionality to directly control a device’s valve. Normally, the device’s valve may freely move up and down as needed to regulate the flow or pressure of the controller device. However, the **Valve Control** feature allows the user to directly take control of the valve position.

This is not available for meter (MFM) devices, as they do not have valves.

If control is set to Analog/External, the software will ask if the user wants to set control to Digital/BEST control. See Figure 11-4.
First, the user selects the desired valve control mode. The current valve control mode is shown on the window.

Normal mode is when the valve automatically moves up and down to regulate flow or pressure.

Open is when the valve is forced fully open. Closed is when the valve is forced fully closed.

Manual is when the user can select a valve position from 0 to 100%. When manual is selected, the Manual Control box on the right side of the form becomes enabled. The user can view and set the valve position (the user must click the Set button or click Set on the Up/Down numeric control). The valve will then be held at this position.

*NOTE: if the user is using an external controller (such as the Brooks 0254) and that controller has its valve override enabled, BEST’s valve control mode may not be able to change the mode or position.

When the user closes this window, if the mode is not in normal mode, the software will ask the user if they want to set the mode back to normal before leaving the window, as a reminder. Normal mode is required for most other functions.

12.3 Delta Device Services

For supported SLA Rev A Delta class devices only, the Delta Device Services menu provides special features to control a device.
Zero Sensor performs the sensor zero operation on the flow sensor for MFC, MFM and RT devices (see also Section 13.2), or on the pressure sensor for PC devices (see also Section 13.4).

Transition to Executing State and Transition to Idle State change the device’s state, for supported devices.

Device Reset performs the same function as the Device Reboot menu (see also Section 12.1).
Chapter 13  Calibration Menu

The Calibration menu guides the user through the process of calibrating and tuning a device. Customer devices are usually calibrated from the factory. However, BEST allows an advanced user to calibrate a device themselves.

A software license is required for most calibration functions. Reference Table 2-2 to determine if calibration features are supported on your device.

Both flow and pressure devices need to be calibrated for accurate control and measurement. The calibration menu includes functions for sensor zero, flow and pressure calibration, valve and response tuning, and analog input and output tuning.

**CAUTION:** Some of the features contained within the Calibration menu can be used to alter the performance of the device. It is recommended that you save the device configuration before proceeding with any calibration or tuning function. For instructions on how to save the device configuration, refer to Section 11.1.

![Calibration Menu](image)

Figure 13-1 Calibration Menu
(not shown: Pressure controller Setup Diagram, RT/Aux Calibration)

13.1 Pressure Controller Setup Diagram

The Pressure Controller Setup Diagram menu displays a basic setup diagram for pressure controller and RT devices. The diagram shows typical setups for an upstream and a downstream application. These diagrams are from the device manual but are available directly from the software as a convenience. These are merely suggested setups for reference – for detailed system analysis consult the device user manual or contact Brooks Instrument.

The form also indicates the configured direction (upstream or downstream) of the current device (See Figure 13-2).
13.2 Sensor Zero

The Sensor Zero menu guides the user through a sensor zero operation on either the device’s flow sensor or pressure sensor. The software automatically detects the device type and sensor type, and displays the appropriate form and performs the corresponding routine. The exact procedure for zeroing the sensor differs according to device type, according to the following subsections.

A sensor zero operation should be performed prior to a full calibration. See the device user manual for device-specific additional information.

13.3 Flow Sensor Zero

A flow sensor zero operation is performed for a MFC, MFM, or RT device in flow control mode. For RT devices, this function zeroes the internal flow sensor, not the remote transducer pressure sensor.

During the flow sensor zero operation there must be no flow through the device. During the zero operation, with no flow, the operation reads the current sensor value, and offsets it so that the reading becomes zero.

*NOTE:* A flow device typically also includes a Zero pushbutton. Pushing that pushbutton performs the same function as the software operation.

Flow sensor zero operations instructions for two types of devices are described in the following subsections:

1. SLA Rev A
2. Quantim

**Zeroing a SLA Rev A Device:**

NOTE: For SLA Rev A Delta Class devices, this same sensor zero feature is also accessible via the Device Control->Delta Device Service menu (see Section 12-3).

To zero the device’s sensor:

1. Allow the device to be powered on for 45 minutes so that it achieves its operating temperature.
2. Close the downstream shutoff valve.
The device should be full of process gas with no pressure differential.

3. Wait at least 30 seconds for the flow signal to drop to zero.

4. Using the device’s Zero pushbutton or the BEST’s software zero sensor function, zero the device:

   - If using the pushbutton, press the pushbutton until the device’s Status LED flashes red, then release the pushbutton. A successful zeroing operation is indicated by the Status LED being a steady green.
   - If using the BEST software zero sensor function, choose BEST's Calibration->Zero Sensor menu item to display the Tuning dialog box.

   ![Figure 13-3 Flow Sensor Zero Window](#)

   Figure 13-3 Flow Sensor Zero Window

   Click the **Zero** button. A message displays when the zeroing operation is complete.

**Zeroing a Quantim Device:**

1. Allow the device to be powered on for 45 minutes so that it achieves its operating temperature.
2. Use the process gas or fluid.
3. Set the Valve Override to open to start flow through the device.
   For information on using the Valve Override, refer to section 12-2.
4. If the process fluid is liquid, allow it to flow long enough to purge any air or gas bubbles from the lines and device.

   **NOTE:** *It may be necessary to cycle the Valve Override from open to closed to clear entrapped air bubbles. If the Valve Override control is not available, then cycle the setpoint between 0 and 100%.*
5. Close the downstream shutoff valve.
6. Wait one or two minutes for the flow signal to drop to zero.
7. Set the Valve Override to closed, make sure the setpoint is zero, and wait again for the signal stabilization. The device should be full of process gas or fluid with no pressure differential and no vibration.

8. Using the device’s Zero pushbutton or BEST software’s zero sensor function, zero the device:

   If using the pushbutton, press the pushbutton until the device’s Status LED flashes red, then release the pushbutton. A successful zeroing operation is indicated by the Status LED being a steady green.

   If using the BEST software zero sensor function, click the Calibration->Sensor Zero menu. The Quantim Sensor Zero window displays. For advanced users, some related attributes are shown in the Configure panel and may be edited. Zero flow configuration values are shown in the read-only fields in the Results panel.

   Clicking the Start button begins the zero sensor process. The process takes about half a minute. When the zeroing completes successfully, the Status field will display “Passed.”

13.4 Pressure Sensor Zero

For pressure controller devices, the Zero Sensor function allows you to zero the device’s internal pressure sensor when there is a no-flow condition. The device also includes a zero pushbutton that performs this same function.

A pressure sensor zero operation is similar to a flow sensor zero operation and is performed for a PC device only on its internal pressure sensor. For RT devices, the external remote transducer pressure sensor is not zeroed using BEST (however, BEST does provide a range calibration for this sensor - see Section 14.6).

NOTE: It is normally not necessary to zero the device’s pressure sensor. However, if you decide that it is necessary, then you will need to pull a vacuum of less than 0.1 torr on the device to ensure actual zero pressure through it.

To zero the device’s sensor:

1. Allow the device to be powered on for 45 minutes so that it achieves its operating temperature.
2. Use the process gas.
3. Set the Valve Override to open to start flow through the device.
   For info on using the Valve Override, refer to Section 12.2.

NOTE: It may be necessary to cycle the Valve Override from open to closed to clear entrapped air bubbles. If the Valve Override control is not available, then cycle the setpoint between 0 and 100%.

4. Make sure the device’s valve-side connection is blocked (for example, by using a shutoff valve).
5. Pull a vacuum of less than 0.1 torr on the sensor side of the device.
6. Wait one or two minutes for the flow signal to drop to zero.
   The device should be full of process gas with no pressure differential and no vibration.

7. Using the device’s zero pushbutton or the software sensor zero function, zero the device:
If using the device pushbutton, press the pushbutton.

If using the software sensor zero function, open the Calibration->Sensor Zero menu and it will bring up the Pressure Sensor Zero window.

![Pressure Sensor Zero Window](image)

Click the Zero button, and the software will indicate when it has completed.

### 13.5 Analog Output Calibration (License Feature)

The **Calibration->Analog Output** menu allows the user to select the mode/range, check the adjustment, change the adjustment, and set some other related attributes. A license is required for this feature.

The **Analog Output Calibration** menu guides the user in verifying and calibrating (or “tuning”) the analog output of the device, if it has an analog I/O option. The analog output provides a DC voltage or current proportional to the flow or pressure reading of the device. The range and type of output is a device option.

A typical setup for calibrating an output voltage is shown in Figure 13-5 and an output current in Figure 13-6. See your device's user manual for specific information about your device. Contact Brooks Instrument to obtain a breakout board for easy connections. An alternative would be to use a device such as a Brooks Instrument Model 0254.
Figure 13-5 Typical Analog Output Calibration Setup, Voltage

Figure 13-6 Typical Analog Output Calibration Setup, Current

The Low Output Cutoff is a percentage of full scale reading below which the analog output is forced to zero volts. For example, if the Low Output Cutoff is set to 5% and an MFC device is reading 4% flow, the analog output will put out 0 volts. To disable this feature, set Low Output Cutoff to 0%.

The other parameters can be changed here as well.

The user can change the Output Configuration mode (voltage or current) by clicking on one of the range buttons. The mode is shown in the Current Mode text box. (See Figure 13-7)

The user can check the current analog output calibration by clicking on the Check button. Then the software will display another window (See Figure 13-8), asking the user to specify a voltage or current. Enter a voltage or current (within the range of the current analog output mode) and click Set. Then verify the voltage as read by an external measuring device (such as a multimeter or Brooks Instrument Model 0254 controller).
Figure 13-7 Analog Output Calibration Window

Figure 13-8 Analog Output Check Window
The user can calibrate the analog output by clicking on the Calibrate button. The calibration process causes the device to output voltage or current at two levels, then performs an interpolation to calculate an offset and factor (or, “base” and “multiplier”).

At each of the two points (low and high), read the voltage or current on an external measuring device, manually enter the value into the software window and click Enter on the entry text box.

Afterwards, the Base and Multiplier values will be updated.

The user may revert back to the original values of all parameters (when the Analog Output form was last opened) by clicking the restore button.
**Quantim Devices**: The analog output calibration for Quantim devices is similar to the SLA Rev A device, except that the Quantim has two analog outputs. After the user clicks the Calibration->Analog Output menu, and before displaying the output cal window, BEST will display a choice for the user to select one or the other analog output.

![Select Primary / Secondary Output](image1)

Figure 13-11 Analog Output Cal, Select Analog Output Window

After selecting primary or secondary, the user will see the primary or secondary analog output window.

![Calibrate Analog Output 1/O: (RNLI MNGR 10)](image2)

Figure 13-12 Primary Analog Output Cal Window
13.6 Analog Input Calibration (License Feature)

The Analog Input Calibration menu guides the user in calibrating (or “tuning”) the analog input of the device, if it has the analog I/O option. If the device’s Control Source is set to External (See Section 8.4), the device responds to an analog input as either a DC voltage or current, changing its flow or pressure set point proportionally to the voltage or current. The range and type of input is a device option.

The Analog Input Calibration menu allows the user to select the mode and range, check the adjustment, change the adjustment, set the Low Input Cutoff and other attributes. A license is required for this feature.

The Input Adjust window allows you to select the analog input mode and set input configuration parameters. Before you begin, perform a sensor zero operation.

A typical setup for calibrating the analog input for voltage is shown below in Figure 13-14 and for current in Figure 13-15. See your device user manual for specifics about your device connections. Contact Brooks Instrument to obtain a breakout board for easy connections. An alternative would be to use a device such as a Brooks Instrument Model 0254.
Figure 13-14: Typical Setup for Calibrating an Analog Input for Voltage

Figure 13-15: Typical Setup for Calibrating an Analog Input for Current
The Low Input Cutoff is a percentage of full scale reading on the analog input below which the device set point is forced to zero. For example, if the Low Input Cutoff is set to 5% and the analog input is at 4%, the set point will be set to 0. To disable, set Low Input Cutoff to 0%.

The Softstart Ramp Time parameter allows user to ramp the set point in a certain time period specified in milliseconds (ms). For default behavior, set this parameter to 0 to allow for the fastest possible set point ramp time.

The user can change the Input Configuration mode by clicking on one of the five range buttons. The current mode is shown in the Current Mode text box.

The user can check the current analog input calibration by providing a voltage or current with an external source (such as a power supply or Brooks Instrument Model 0254 controller) to the device’s analog input, then viewing the measured input “live” level in the Measured Input text box.

Note: Sometimes the valve may oscillate during the time between adjusting setpoint input base and multiplier. This is a normal event that will resolve itself immediately after setpoint input multiplier is adjusted.

The user can calibrate the analog input by clicking on the Calibrate button. The calibration process prompts the user to supply external voltages or currents to the device’s analog input at two levels (high and low), then performs an interpolation to calculate an offset and factor (or, “base” and “multiplier”).

At each of the two points (low and high), supply an external voltage or current as directed. The live voltage or current is shown in the Measured Input text box. Click Accept when ready each time.
The user may revert back to the original values of all parameters (when the Analog Input form was last opened) by clicking the restore button.

### 13.7 RT/Aux Input Calibration

For RT devices, the **RT/Aux Input Calibration** menu allows the user to enter scaling attributes for the remote transducer input. The auxiliary input of an RT device is normally connected to the external ("remote") pressure transducer sensor.

This operation adjusts the input sensitivity to the sensor’s range (0 to 5V or 0 to 10V - see your device user manual for details).

When the user clicks on the Calibration->RT/Aux Input Calibration menu, it opens the Pressure Sensor tab of the Config Parameters window (see also Section 14.6). At this window, the user can view and modify the attributes.
13.8 Cal Pages

The Cal Pages menu is where the user can select the active calibration page, and create default pages. A "page" is a configured and calibrated set-up of the device. A page is created at the factory, via the calibration process (Chapter 13), or by creating a default page (from the Cal Pages form). A page is selected from the set of pages (the "calibration data set") that have previously been created. For pressure controller devices, a page is also called a "pressure application."

Typically, this menu item is of interest only to users who have a device with more than one calibration page stored in the device.

Quantim devices do not support cal pages, as they only have one page, the "active" page.

Flow devices and pressure devices each have a separate set of possible pages and thus, different Cal Pages windows. There are separate menu items for flow pages and pressure pages – Cal Pages (Flow) and Cal Pages (Pressure) - (see Figures 13-19 and 13-20).

MFC and MFM devices have flow cal pages, PC devices have pressure pages, and RT devices can have both types.

13.9 Flow Cal Pages

The Cal Pages window for flow devices is shown in Figure 13-19.

![Cal Pages Window, for Flow Devices](image)

Figure 13-19 Cal Pages Window, for Flow Devices

The Process Gas Pages section of this form is where the user can view and select from the existing set of created calibration pages. To see the complete set of pages present in the device, click on the Process Gas Page drop-down box.

The active page is prefixed with an asterisk in the Process Gas Page drop-down box. Possible page numbers are 1 through 10. To activate a page, select one of the pages from the drop-down box, then click Activate. To view selected parameters of a page, select the page from the drop-down box, and the parameters are shown below the drop-down boxes.

Pages cannot be deleted.
To create a new flow page: For Delta devices, click the Create Default Page button which will open another window to create pages. For Delta Lite/Smart II devices, the Create Default Page button will not appear: use the full calibration process, where supported.

Analog page selection (also called Analog Function Selection) is the feature where an analog input pin on the device’s connector can be used to select the active page externally. If analog page selection is supported and is active, the external pin selects the active page and the page cannot be selected via BEST software – the selection controls will be disabled (see your device user manual for details for your device for Analog Function Selection).

If a device supports analog page selection, the Analog Page selection check box will be enabled. If analog page selection is currently enabled, the checkbox will be selected – if not, the checkbox will not be selected. The user may enable and disable analog page selection by checking and unchecking the Analog Page Selection checkbox.

For some older devices (SLA Rev A devices with firmware rev. <= AE), a simpler page selection window will appear. Note with these devices, note the warning that selecting a page number that doesn’t currently exist will create that page.

![Cal Pages Window](image)

Figure 13-20 Cal Pages Window, for Flow Devices, (legacy firmware)
13.10 Pressure Cal Pages

The Cal Pages window for pressure devices is shown in Figure 13-21.

![Pressure Application Pages](image)

The Pressure Application Pages section of this form is where the user can view and select from the set of created pressure calibration pages. To see the complete set of pages present in the device, click on the Pressure Application Page drop-down box.

The active page is prefixed with an asterisk. Possible page numbers are 1 through 10. To activate a page, select one of the pages from the drop-down box, then click Activate. To view selected parameters of a page, select the page from the drop-down box, and the parameters are shown below the drop-down boxes.

Pages cannot be deleted.

A license is not required to create pages. To create a default page, click Create Default Page. A new window appears as shown in Figure 13-22.
Figure 13-22 Create Default Page Window, for Pressure Devices

In this form, the Existing Pressure Pages section shows the existing pressure calibration pages, the same as in the previous form (but you can’t change the active page this drop-down control, this is just for viewing purposes).

In the New Pressure Page section, it shows selected parameters that will be used in the new default page. For pressure controller devices, the Full Scale Range here must be <= the internal transducer range.

Below that is the New Pressure Page Number drop-down box. The user can select a page number from 1 to 10 for the new page.

The RT panel is only shown for RT devices.

To create the new page, click Create Default Page. If the user selected a page number that already exists, the user will be prompted whether they want to overwrite the existing page. Note that the "default page" that is created is not a calibrated page. The calibration attributes must be entered in the Delta Config Parameters form.

Once the new page is created, it will appear in the list of process gas pages.
13.11 Calibration (License Feature)

SLA Rev A Delta and Quantim devices typically come from the factory pre-calibrated and thus do not normally need to be re-calibrated in the field. As of this release, BEST supports a semi-automated calibration only for SLA Rev A Delta Smart II devices. This requires a license. This is described in this chapter.

For other device types, flow control or pressure control calibration can be performed by manually calculating and entering calibration coefficients and other data using the Config Parameters window (see Chapter 14 for SLA Rev A devices, or Chapter 15 for Quantim devices). A license is not required for these adjustments.

13.11.1 Flow Calibration - SLA Rev A Delta Smart II Devices

BEST provides a semi-automated flow calibration for SLA Rev A Delta Smart II devices.

With supported devices, devices can create multiple flow calibrations in a device, stored in “pages” in the device. The user can then switch between calibrations by selecting pages.

The software automatically detects the device type and guides the user in the appropriate type of calibration to perform. The processes and windows that appear may be different depending on the device type and calibration type.

The calibration process typically involves the following steps: setting up a calibration, performing the calibration, validating the calibration, and producing a calibration report.

To perform a calibration, the following conditions are required:

- The device has been powered on for a sufficient time to be warmed up.
- The sensor has been zeroed.
- There is a supply of gas.
- During the calibration process, the device must be in a thermally stable environment. Rapid or significant temperature changes during the calibration process will affect the device’s accuracy. See also the device user manual.

Calibrating a meter (MFM) device is very similar to calibrating a Mass Flow Controller (MFC). There are a few steps that are slightly different and are described in these instructions where needed. The main difference is to make sure you have a bench setup that can manually adjust the flow going through the meter device. See also section 11.6 for instructions for simulating an MFC device with a meter for calibration purposes.

*NOTE: Make sure that the model code information is set correctly prior to starting calibration (see Section 11.3).

An example flow calibration window is shown in Figure 13-23.
At the top of the window is the DUT Information block. This information is read-only and is for informational purposes only. The Device Configuration text box is the model code.

Below that are four tabs: Pre-Cal, Calibration, Linearization, and Validation (See Figure 13-23). The user normally executes these tabs in order from left to right. Select each tab by clicking on it.

**Pre-Cal Tab:** The Pre-Cal tab is performed first. The Pre-Cal tab is shown selected in Figure 13-23.

Below the Pre-Cal tab are a number of user-editable entry fields. When the calibration window is first opened, these user-editable fields are initially populated from the current page of the device if it exists (except for reference pressure and units which are set to the last user-entered values).

Alternatively, the user may click Set Default Parameters which will fill all the fields with default values. This may be a good starting point for some users.

In most calibration scenarios, the user may need to change these values. For example, some users may perform calibration with a gas that is different than their process gas (for example, a user may have a process gas of Ar, but may calibrate with N2). BEST software can accommodate these scenarios. The Pre-Cal tab information is for the calibration gas, so if the user’s calibration gas is different than their process gas, they will need to change this information to their calibration gas.
When changing the parameters, the user typically changes the values from top to bottom (i.e., changes the Process Gas Symbol first, then Process Ref Temperature, etc.).

As the user changes these values (and moves the cursor off the text box), the Process Flow Range value is automatically re-calculated, taking into account the other parameters in order to convert the range to its equivalent. Finally, the user may manually change the range lastly, if they need to adjust the auto-calculated range value. In the Pre-Cal tab, usually this range value will be the equivalent of the full scale range from the model code.

Clicking Get Gas Density will look up the gas density for the entered process gas, adjust it for the entered reference temperature and pressure, and display it under the Process Gas Density box.

Cal Gas Correction Factor is the factor comparing the flow of the cal gas to the process gas.

Make sure to select the gas page number in which you want to store the resulting calibration.

The user may then click Create Pre-Calibration Gas Page.

*NOTE: Always double check all user-entered values before clicking the create page button.

The software will warn the user that the create process will overwrite the target page if it already exists. After a few moments, the pre-cal page will be created. The status bar will indicate success or failure of the page creation process. The process will also make the selected page number the active page.

After you have successfully created the pre-cal page, you can proceed to the next tab, by clicking on the Calibration tab.

**Calibration Tab:** The Calibration tab is shown selected in Figure 13-24.
The Calibration tab performs a calibration using the Pre-Cal page created in the previous subsection as a starting point.

The Zero Sensor button performs the same function as the Calibration- >Zero Sensor menu item (Section 13.2.1). The sensor should be zeroed prior to starting the calibration on the Calibration tab.

Optimize sensor performs an automated adjustment for the sensor range. This is optional. It should be done before starting the grid measurements.

The Point Stabilize Delay value determines how much time delay occurs after clicking a set point button before the user may enter a flow value. This is to help prevent the user from entering a flow value before the flow has stabilized after changing a set point. The delay for the Calibration tab is always the same value as for the validation tab (see Validation Tab section below).

The grid in the center of the Calibration tab is the calibration grid. Each row of this grid represents a set point. Each column represents a measurement at the set point. A number of set points will be measured, and characterized to provide a correction for accuracy.

The two set point columns represent the set point values in percentage (of full scale) and absolute flow units. The number and values of the set points are user-configurable.

To change the set points, click on the Edit Points button. The Edit Setpoints window appears, as shown in Figure 13-25.

Type in or edit a semicolon-separated list of set point percentages. Rules for the set point list are as follows:

- Must be a semi-colon-separated list.
- Number of points must be between 2 and 12.
- All fields must be a numeric integer or floating point.
- All numbers must be between 0 and 100.
- List may not contain duplicate numbers (duplicate numbers are allowed on the on the validation tab).
• Numbers must be incremental, left to right (non-incremental numbers are allowed on the validation tab).

To set the list to its default set, click Default.

When done, click Save, then Exit. The calibration grid now contains the new set of set points.

The first row of the grid contains the titles of the columns. The second row contains the units for each column.

The calibration of a setpoint is started by clicking on a Click button in one of the rows under the StartMeas Column. Clicking on one of these buttons starts a live measurement at the set point of the clicked row. The software will set the device’s set point to the value in the set point column, and then continually read the device’s output including flow, temperature, and valve position. See Figure 13-26.

![Figure 13-26 Calibration Tab, Filled Out](image)

**NOTE:** When performing this calibration with a meter type device, a pop-up window will appear, prompting the user to manually adjust the flow through the device (See Figure 13-27). Since meter devices do not have a valve, the user must adjust the flow manually in their system. Also, the Valve Position column will not show valid data for a meter device, of course.

![Figure 13-27 Flow Cal, Meter Setpoint Prompt](image)

An external flow measuring instrument is required. The user will read the flow measurement from the external instrument and manually type it into the Actual Flow column.
*NOTE: If the actual flow is not within 5% of the set point, the MFC output columns will turn red as a warning. When calibrating meters, take care to accurately manually adjust the flow rate (until the columns are no longer red).

To go to another row (another set point), click a Click button in one of the other rows under the StartMeas Column. All rows must be filled out to continue the calibration beyond this tab. Set points can be completed in any order.

To stop live measurements, click the Stop Meas button or click on another tab.

The Zero Set Point button changes the device set point to 0% (useful if the set point list does not contain 0%) and stops the live measurements.

When you have filled out the grid info for all set point rows, you should click Stop Meas.

Then you can proceed to the next tab, by clicking on the Linearization Page tab.

**Linearization Tab:** The Linearization tab is shown in Figure 13-28.

The linearization tab process uses the calibration data from the Calibration Tab to calculate polynomials for a curve fit and then stores these coefficients in the device, upon clicking on Calculate Polynomials.

When finished, click on the Validation tab.

**Validation Tab:** The Validation tab is shown selected in Figure 13-29.
The Validation tab performs a validation check of the calibration. The page verified is the current page.

The grid in the center of the Calibration tab is the validation grid. Like the calibration grid, each row of the validation grid represents a set point. Each column represents a measurement at a set point. A number of set points will be measured and checked for accuracy.

The set point columns represent the set point values in percentage and absolute flow units. The number and values of the set points are user-configurable. The set of validation points does not need to match the set of calibration points. To change the set points, click on the Edit Points button. The Edit Setpoints window appears, as shown in Figure 13-25, the same way as for calibration set point selection.

The Point Stabilize Delay value determines how much time delay occurs after clicking a set point button before the user may enter a flow value. This is to prevent the user from entering a flow value before the device has stabilized (in terms of flow control) after changing a set point. The delay for the Validation tab is always the same value as for the Calibration tab (see Calibration Tab section above).

The first row of the grid contains the titles of the columns. The second row contains the units for each column.

Like the calibration tab, the validation for a set point is started by clicking on a Click button in one of the rows under the StartMeas Column. The software will set the device’s set point to the value in the set point column, and then continually read the device’s output including flow, temperature, and valve position. See Figure 13-29.
**NOTE:** when performing this validation with a meter device (MFM), a pop-up window will appear, the same one that appears for the Calibration tab, prompting the user to manually set the flow through the device (See Figure 13-27). Since meter devices do not have a valve, the user must set the flow manually in their system. Also, the Valve Position column will not show a valid value for meter devices.

**NOTE:** If the actual flow is not within 5% of the set point, the MFC output columns will turn red as a warning. When calibrating meters, take care to accurately manually adjust the flow rate (until the columns are no longer red).

**NOTE:** The accuracy calculation is the comparison of the expected flow and external actual measurement. The pass/fail criteria (red or green) is based on the percentage of full-scale for all points.

Like the calibration tab, in the validation tab the user must enter the actual flow into the Actual Flow column, the column with a yellow background. An external flow measuring instrument is required. The user will read the flow measurement from the external instrument and manually type it into the Actual Flow column.

To go to another row (another set point), click a Click button in one of the other rows under the StartMeas Column. All rows must be filled out with valid numeric data to complete the validation and create a certification sheet (see section “Create Cert” below). Set points can be completed in any order.

Once a user types in an actual flow value, the error percentage is automatically calculated and updated for the current row.

Clicking the Validate Accuracy button stops live measurements and recalculates the accuracy for all set points (all rows). The accuracy calculation compares the target set point/flow rate to the (manually entered) external meter value.

At any time, to stop live readings, click the Stop Meas button.

The Zero Set Point button stops live measurement and changes the device set point to 0% (useful if the set point list does not contain 0%).

When you have filled out the grid info for all set point rows, you should click Stop Meas. Then, if desired, you can proceed to print a certification report, (see next section).

**Create Cert:** Once the validation is completed, the user can print out a certification sheet (or “Cert”). This is a report showing the validation results data and some custom user information.

Click the Create Cert button. A window will open showing a pre-selected set of configuration data. It also allows the user to choose a set of custom configuration data items that will appear on the report, in addition to the calibration data. The user may select, edit, and save the set of custom configuration data for the report (See Figure 13-30).

The fields with a white background are initialized with values from the device or software. Fields with a yellow background are initialized with values from a user profile. A user profile is a set of user-selected values that are stored so that the user does not have to repeatedly type in the same values. The user saves a set of values in a profile, creates a profile, and selects a profile. The fields with a gray background cannot be changed by the user. The user may also select the image that appears on the footer of the report. The user may choose the default, or may provide their own logo.
The user may also select the number of decimal places that appear in the tabular data on the report, via the Decimal Places box.

Figure 13-30 Flow Cal, Cert Sheet Preview Page

After this, click Generate Report and a preview of the report will be displayed.
From there, the user may view, print or save the report to file.

13.11.2 Pressure Controller Calibration

Pressure controller calibration is performed for SLA Rev A Delta class pressure controllers by manually calculating and entering calibration coefficients and other data using the Config Parameters window (See Section 14.6). A license is not required for these adjustments.

13.11.3 RT Device Calibration

Flow calibration is performed for SLA Rev A Delta class RT devices by manually calculating and entering calibration coefficients and other data using the Config Parameters window (See Section 14.6). A license is not required for these adjustments.
Pressure calibration is performed for an SLA Rev A Delta class RT device’s remote transducer pressure sensor by manually calculating and entering calibration coefficients and other data using the Config Parameters window (See Section 14.6). A license is not required for these adjustments.

13.12 Valve Tuning

The Valve Tuning menu is whereby the user can check and optimize the range of the valve, as well as adaptive control, for MFC, PC and RT devices. MFM devices do not have a valve, so valve tuning is not applicable. Optimization can be done manually, or using an automated routine for some devices (auto valve tuning is not supported for the Quantim Device).

Valve Tuning function allows you to tune two valve parameters to optimize its performance:

- Valve offset (flow off, 0%)
- Valve span (at flow + span, flow is just at full-scale, 100%).

All valve offset values are calibrated at the factory at the conditions specified on the device’s order. Device performance can be affected by contaminants or pressure changes. Tuning the valve offset and span can help to optimize the valve response.

At process conditions with process flow:

- The valve offset value corresponds to the valve position (measured as a percentage from fully closed to fully open) at which flow is off.
- The valve span value is used to determine the valve position—offset + span—at which flow is just at full-scale.

All valve offset values are calibrated at the factory at the conditions specified on the device’s production order.

*CAUTION:* It is highly recommended that you save the device configuration using the save dump file feature to save the device’s current configuration before making any changes to the valve offset and span. This will allow you to restore a working configuration if the valve tuning operation results in incorrect settings or faulty operation. For more information, refer to section 1.1.

The Valve Tuning window is accessed by clicking the Calibration-> Valve Tuning menu. The Valve Tuning Window is shown below in Figure 13.32.
The Manual Tune panel is where the user can manually adjust the offset and span of the valve range. The Valve Control panel is where the user can manually control the valve position. Adaptive Control is where the user can control the adaptive control mode of the valve, where supported by the device. Auto Tuning is an automated algorithm that can assist the user in setting the valve range, depending on the device type.

13.12.1 Checking Offset and Span Values

To check the offset and span values:

1. The Valve Tuning window is accessed by clicking the Calibration -> Valve Tuning menu.
2. Set inlet and outlet pressure conditions to match those specified on the device’s order or on its Calibration Report.
3. Click the Adaptive Control Disable button to make sure that Adaptive Control is not on.
4. In the Valve Control panel, click the Manual button to enable manual control of the valve.
5. Starting with 0, enter percentage values in the Valve Position field until the flow text box reports (1%) (do not reference an external flow measuring instrument here)

At this point, the value in the Valve Position field should be very close to the value shown in the Valve Offset (Stored) field. Some small difference between Valve Position and Valve Offset (Stored) is acceptable.

6. Continue to enter higher values in the Valve Position field until 100% flow is reached.
At this time, the value in the **Valve Position** field should be very close to the sum of the values in the **Valve Offset (Stored)** and **Valve Span (Stored)** fields. Some difference in these values is acceptable.

You should adjust the offset and span values if one of the following are true:

- The process conditions are now different from that specified on the device’s order.
- The valve position that produces a flow rate of 1% does not closely match the offset value in the **Valve Offset (Stored)** field.
- The valve position that produces a flow rate of 100% does not closely match the current offset + span values in the **Valve Offset (Stored)** and **Valve Span (Stored)** fields.

You can use either Manual or Automatic mode to adjust the offset and span values, as explained in the following two subsections. If the Automatic tune mode is not able to control the device, use the Manual method.

### 13.12.2 Adjusting Offset and Span Values - Manual Tuning - For MFC Devices

To adjust the offset and span values manually for MFC (and RT) devices:

1. Set inlet and outlet pressure conditions to your process or application specs.

2. Click the Calibration-> Valve Tuning menu.

3. Click the Adaptive Control **Disable** button to make sure that Adaptive Control is not on. In the Manual Tuning panel, click the **Manual** button to enable the **Valve Position** field.

4. In the Adaptive Control panel, Enable Adaptive control if desired and set the adaptive Control mode.

5. Starting with 0, enter incremental values in the **Valve Position** field until flow just begins (press the Enter key after entering a value). Make sure you have stopped at 1% flow.
   
   - **NOTE**: Do not overshoot and then decrease the valve value to locate the offset position. Because of valve hysteresis, you must start at zero and find the offset value only by increasing up from zero.

6. Press the **Save Offset** button for the offset to save the new offset value.

7. Once the offset value is determined and set, continue to slowly increment the current valve value. As flow rate approaches 100%, enter values in smaller increments until 100% flow is achieved.

8. Allow the flow rate to stabilize. When the flow rate has stabilized, press the **Save Span** button to save the new span value.

9. Enter different values in the **Value Position** field to determine whether or not the newly saved offset and span values produce the desired flow rates, that is, 1–2% with the valve drive at offset, and 100% with the valve drive at offset + span.
10. Click the **Normal** button in the Valve Control panel to return the valve to its normal operating state.

11. In the Adaptive Control panel, Enable Adaptive control if desired and set the adaptive Control mode.

**13.12.3 Checking and Adjusting Offset & Span Values - Manual Tuning - For Pressure Devices**

*NOTE:* It is normally not necessary to adjust the valve offset and span for a pressure controller. Valve offset and span adjustments need to be adjusted only if proportional and integral gain adjustments do not result in satisfactory performance.

When performing the valve tuning, it is important to note the distinction between the pressure controller being upstream or downstream of the pressure vessel. This can be checked on your device in BEST by the Calibration->Pressure Controller Direction menu, or by the Device Config-> Model Code menu.

To check and adjust the offset and span values:

1. Under Graph Options, change the pressure and pressure setpoint units to percent.

2. Start the main graph.

3. Establish full scale flow into (upstream) or out of (downstream) the pressure vessel by:
   - Set the pressure controller’s valve override to Open. (Refer to Section 12.2 for valve control).
   - Set flow to full scale.

4. Establish a minimum pressure for the device:
   - **For a downstream pressure controller**, set the valve override to Closed.
   - **For an upstream pressure controller**, set the valve override to Open.
   - Wait for pressure to stabilize. The minimum pressure is the pressure reading + 2%. Note that for a downstream controller with the Valve Override closed, the pressure vessel should "empty" and thus the pressure should become 0 (assuming flow into a vacuum and no flow leak-by at the pressure controller).
   - Record the minimum pressure.

5. Set the valve override to Normal.

6. In the main graph window, enable the digital setpoint control, then enter the minimum pressure determined in step 4 in the setpoint field.

7. Determine the offset:
   - Wait for the flow to stabilize. The offset valve setting will be the Valve Output value – 5% (use the Valve Output value, not the Valve Drive value). Record this value.

8. Determine the span:
• Set the setpoint to 100%.
• Wait for the flow to stabilize. The span valve setting will be the Valve Output value. Record this value.

You should go on to step 10 and adjust the offset and span values if one of the following are true:

• The process conditions are now different from that specified on the device’s order.
• The valve value that produces a flow rate of 1–2% does not match the current offset value in the Direct Parameter Update panel’s Valve Offset field.
• The valve value that produces a flow rate of 100% does not match the current offset + span values in the Direct Parameter Update panel’s Valve Offset and Valve Span fields.

9. Open the Tune menu and choose Valve. The Valve Tuning window opens.

10. Enter the offset and span values:
  • Enter the offset value determined in step 7 and click the Save Offset button.
  • Enter the span value determined in step 8 and click the Save Span button.

11. Enter the offset and span values:
  • Enter the offset value determined in step 4 in the Offset (New) box and click enter (do not click the Save Offset Button).
  • Enter the span value determined in step 5 in the Span (New) box and click enter (do not click the Save Span button).

13.12.4 Adjusting the Offset and Span Values - Auto Tuning

The Auto Tune function determines the valve offset and span values automatically. The auto test takes several minutes to execute. Auto valve tuning is not supported for the Quantim Device or for pressure controller devices.

To adjust the offset and span values using the Auto Tune function:

1. Set inlet and outlet pressure conditions to your process or application specs.
2. The Valve Tuning window is accessed by clicking the Calibration-> Valve Tuning menu.
3. The step values (high and low) are shown in the Auto Tuning panel. These values define the low and high valve step values that will be used to adjust the valve during the second phase of the Auto Tune operation. These can be adjusted if desired. The Dwell values determine how long to maintain the step value before switching to the next value. These can also be adjusted if desired. Delay should be long enough for the flow to settle after changing setpoints during the auto test.

*NOTE: It is recommended to keep the User Inputs parameters at their default settings.
4. Click the Auto Tune button to start the auto tune operation. The Auto Tune operation starts.

In the first adjustment phase of the auto tune operation, the device valve is opened in gradual steps to determine an approximated rough valve offset and span.

In the second adjustment phase, the setpoint is repeatedly cycled (according to the setpoint cycling values that you specified) until offset and span differences are below an acceptable threshold, or for a maximum of six cycling periods. This adjustment process can take several minutes.
When the Auto Tune operation is complete, a message box displays, and new offset and span values will be set.

The Valve Tuning Adaptive Control function, when supported by the device and enabled, causes the device to dynamically adjust valve offset and span, or just offset, while the device is operating.

If process conditions change significantly (such as moderate shifts in inlet or outlet pressure) while Adaptive Control is enabled, valve offset and span will dynamically self-adjust for optimum valve performance under the new process condition without requiring operator intervention.

To set Adaptive Control settings, click menu item Calibration->Valve Tuning under the Adaptive Control panel (see Figure 13.32), or alternatively, access it under the Device Config->Config Parameters menu under the Valve tab (see Section 14.8 for SLA Rev A devices or 15.9 for Quantim devices).

**NOTE:** When adaptive control is enabled, offset and/or span may change dynamically. However, these changes are not permanent, and the device returns to the stored offset and span after a power cycle or system reset.
13.13 Response Tuning

The **Response Tuning** menu is where the user can optimize the timing response of the valve. MFM devices do not have a valve, so valve tuning is not applicable. Response tuning optimizes the dynamic response of the device to changes in set point. You can use this feature to eliminate undesired under- and overshoot.

If the mass flow controller device supports the Improved Response and Control feature also PID Kd (derivative gain) value can be changed. If this feature is not supported by the mass flow controller device the PID Kd value cannot be changed.

Users can tune valves on either flow or pressure control devices. The process is very similar for both. Flow devices (MFC’s) are tuned in flow control mode, and pressure devices (PC’s) are tuned in pressure control mode. RT devices may be tuned in either mode: first select the mode (Device Control->RT Control Mode menu). This section describes the process for response tuning for flow controllers. The following section describes the process for response tuning for pressure controllers.

*Note:* For devices calibrated at the factory, response tuning adjustments should typically not be necessary, as calibrations are performed to the device’s specified process conditions. If you do want to adjust the response tuning, it is strongly recommended that you only adjust the PID Kp and Ki (proportional and integral gain). Only in rare occasions the Kd1 and Kd2 (derivative gain) values might improve performance. Do not adjust the Flow Control K-up and K-down values. For Service Suite training, which includes training for response tuning, contact your local Brooks service representative.

*NOTE:* Make sure that you have saved the device configuration prior to adjusting these values.

The valve tuning process typically involves cycling the flow or pressure between a high and a low set point value, while watching and adjusting the parameters that control the response of the valve. The objective is to minimize overshoot and undershoot.

To tune the device’s response, you will set up a square wave for the set point. You will then make adjustments to tuning parameters to make the actual flow graph match the set point’s square wave.

13.13.1 Response Tuning (Flow)

The user will open the main graph window (See Section 8.4) and start the monitoring. For valve tuning, it is recommended that you choose % as your units of display for setpoint, pressure and flow. Make sure the graph can display your range of flow values (Settings->Graph Options menu).

Then the user will open the Calibration->Valve Tuning menu and make adjustments there while watching the performance on the main graph. Position the Graph window so that you can see the Tuning and Graph windows at same time.
The flow controller valve response tuning setup window is shown in Figure 13-37 and 13-38, and the pressure controller valve response tuning setup window is shown in Figure 13-46.

Set up the set point square wave in the Cycling block of the Tuning window. Pick high and low set points that are at the expected range of your process application.

The Cycling block in this window allows the user to select parameters determining the high and low set point of the cycling. The Switching Time determines how often the set point changes state during the cycling. Choose a switching time that allows enough time for the flow response to settle after the setpoint changes. The Start button starts the cycling and the Stop button stops the cycling.

*Note: If you are adjusting a meter model (MFM), use a separate flow controller to regulate the set point cycling.
Make sure that the **Adaptive Control Enable** option is disabled.

Apply gas flow to your device.

Click the **Start** button to begin the cycling.

Observe how closely the actual flow matches the set point square wave. Start making adjustments using the PID Kp and Ki (proportional and integral gain) values. In general, flow response should be as fast as possible with minimum overshoot (less than 5%).

Start making adjustments using the PID Kp and Ki (proportional and integral gain) values. (Do not adjust the Flow Control K-up and K-down values.) The Adjustments block is where the adjustments are made during the cycling. When changing values, always remember to click **Apply**.

If you are having difficulty getting the actual flow graph to look like the setpoint square wave, you can restore the initial settings that were in effect when the window was opened by clicking the **Restore Settings** button.

![Figure 13-39 Flow Valve Tuning Operation](image)

**Effect of Kp and Ki Values on Flow Control**: The following screens show some examples of what the flow graph looks like when Kp and Ki values are too high or too low.
Start with the original PID settings. Note that these may vary per device.
Increase the Kp value, the slope of the red circled part will slightly increase.

Increase the Ki value, to move the flow curve towards the set point curve. This change will be the most visible but might lead to overshoot and undershoot.
*NOTE: If you need a higher data sample rate (resolution), change the graph options to show fewer parameters (see section 7.1). Uncheck the Auto Show Default Parameters check box and select only the parameters you need to view. Unchecking the Valve Position parameter can yield significant increases in sample rate.
13.13.2 Response Tuning (Pressure)

Pressure response tuning optimizes the dynamic performance of the pressure controller device to changes in set point. You can use this feature to eliminate undesired undershoot and overshoot.

The proportional and integral gain settings control the rate at which the valve responds to changes in setpoint. You can adjust these values to tune the valve's response. The optimal proportional and integral gain settings depend on the volume of the pressure vessel and the full-scale flow rate.

To tune the device's response, you will set up a square wave for the set point. You will then make adjustments to tuning parameters to make the actual pressure graph match the set point's square wave.

To tune the valve response:

1. Make sure the trending graph can display the range of setpoints between which you want to cycle. For more information about setting the maximum and minimum range displayed on the trend graph, refer to Section 7.1.
2. Open the main graph and start monitoring.
3. If the device is an RT device, make sure it is in the pressure control mode (Device Control->RT Control Mode menu).
4. Open the Calibration->Valve Tuning menu. The Valve Tuning (Pressure) window opens.
5. Initially, set Proportional Gain to 5 and Integral Gain to 0.2.
6. In the Cycling panel, set the cycling conditions you want to use:
7. Enter the high setpoint value for your process conditions.
8. Enter the low setpoint value for your process conditions.
9. Enter the switching time – enter enough time for the pressure to stabilize after the set point changes.
   • **NOTE**: The cycle time required to reach stable flow is highly dependent upon the volume of the pressure vessel and the maximum flow.

10. Select the **High and Low** option to have the cycling continue until you manually stop it.

11. When you have completed entering the cycling conditions, click the **Start** button to start the cycling process.

12. Observe the mass flow and valve drive graph to see how well the valve is responding to the changes in the setpoint.
   • In general, flow response should be as fast as possible with minimum overshoot (less than 5%).

13. If the valve response needs tuning, change the Proportional Gain and Integral Gain values until the valve response is satisfactory.

When adjusting the Proportional (Kp) and Integral Gain (I) values in the Tune Response Form window, observe the following guidelines:

   • Increasing the proportional gain value and/or decreasing the integral gain value speeds up the response time. Conversely, decreasing the proportional gain value and/or increasing the integral gain value slows the response time.

   • To achieve the desired flow response, first adjust the Proportional Gain value in 0.1 increments, and then adjust the Integral Gain value in 0.05 increments.

**NOTE**: If you need a higher data sample rate (resolution), change the graph options to show fewer parameters (see section 7.1). Uncheck the **Auto Show Default Parameters** check box and select only the parameters you need to view. Unchecking the Valve Position parameter can yield significant increases in sample rate.
Chapter 14 Viewing and Setting the Device Configuration (SLA Rev A)

This chapter describes how to view and set device configuration parameters for the SLA Rev A device. (For the equivalent device configuration parameters for the Quantim device, see Chapter 15). These setting are accessible in the windows of the Device Config- >Config Parameters menu.

Some control parameters can be modified, indicated by their field having a white background. Others can only be viewed (and not modified) indicated by their field having a grey background.

NOTE: When modifying the values, always remember to click Write to save the values to the device permanently.

When each window is opened, it takes a one-time reading of the parameters. To take another reading, click Read Once. To continuously read the parameters (once per second), click Read Continuous.

The actual parameters accessible/visible may vary depending on the device type and options.

NOTE: Any changes you make to the device configuration parameters are saved permanently to the currently connected device. Prior to making changes to device configuration settings, it is recommended that you save the current settings. This will allow you to restore the device configuration to a known, working state (see Section 11.1).

14.1 Viewing the Control Response Parameters

Some response parameters on the Control:Response - Flow tab are settable here. However, it is recommended that you adjust the proportional and integral gain values via the Response Tuning window – (refer to Section 13.13).

Figure 14-1 Control->Response - Flow
Some response parameters on the Control:Response - Pressure tab are settable here. However, it is recommended that you adjust the proportional and integral gain values via the Response Tuning window – (refer to Section 13.13).

Figure 14-2  Control->Response - Pressure

Figure 14-3  Control->Config-Flow
The Softstart Ramp parameters allow you to configure the ramp behavior during a soft start of the device.

**To configure the softstart ramp behavior**, set the Softstart Ramp options as described below:

- **Type.** Choose one of the following:
  - **Off.** Device will transition to new setpoint as quickly as possible.
  - **Ramp Time.** Device will transition to a new setpoint in the number of seconds specified in the **Time** field.
  - **Slope.** Device will transition to a new setpoint at the rate specified in the **Slope** field.
  - **Time.** Ramp time, in seconds.
  - **Slope.** Ramp rate, in percent/sec.

An additional parameter, **Setpt Low Signal Cutoff**, may appear, which specifies the setpoint value below which the analog setpoint input is considered to be zero.
Selected device information is shown here. The device information parameters are read-only.
14.3 Viewing Filter Parameters

![Image of Filter Parameters]

Figure 14-7 Filters

14.4 Viewing Flow Sensor Parameters

![Image of Flow Sensor Parameters]

Figure 14-8 Flow Sensor->Flow Calibration
Figure 14-9  Flow Sensor->Cal Conditions

Figure 14-10  Flow Sensor->TruCal
Figure 14-11 Flow Sensor->Custom

Figure 14-12 Flow Sensor->Zero
Figure 14-13 Flow Sensor->Response

Figure 14-14 Flow Sensor->Corrections
Figure 14-15 Flow Sensor->Scaling
14.5 Setting the Output Signal Behavior

You can set the behavior of the output signal.

![Image of Delta Configure Parameters](image)

Figure 14-16 Outputs

The **Analog Output Mode** setting determines the output signal behavior. The choices are:

- **Downscale.** Output will go to 0 V.
- **Hold.** Output will remain at the value in effect when changed to Hold mode.
- **Manual.** For Brooks internal use only.
- **Tracking.** Output will continue to report the value of the measured process variable.
- **Upscale.** Output will go to 5.5 V.

The **Signal Filter** field allows you to dampen the output signal change relative to changes in flow by specifying the transition time, in seconds.
14.6 Viewing and Setting Pressure Sensor Parameters

For devices with a pressure sensor, you can view the pressure sensor parameters:

![Image of Pressure Sensor Parameters]

Figure 14-17 Pressure Sensor

14.7 Viewing and Setting Setpoint Parameters

For devices with setpoint control, you can view the setpoint parameters:

![Image of Setpoint Parameters]

Figure 14-18 Setpoint->Flow
14.8 Viewing and Setting Valve Parameters

You can view various valve adjust settings, and set parameters related to valve control.
Figure 14-21 Valve->Adjust-Pressure

Figure 14-22 Valve->Config-Flow
The Adaptive Valve Control function, when enabled, causes the device to dynamically adjust valve offset and span, or just offset, while the device is operating.

If process conditions change significantly (such as moderate shifts in inlet or outlet pressure) while Adaptive Control is enabled, valve offset and span will dynamically self-adjust for optimum valve performance under the new process condition without requiring operator intervention.

**NOTE:** When adaptive control is enabled, offset and/or span may change dynamically. However, these changes are not permanent, and the device returns to the stored offset and span after a power cycle or system reset.

The Valve:Adaptive Control tab includes the options that allow you to enable Adaptive Control and set its operating parameters.
Figure 14-24 Valve->Adaptive Control - Flow

To enable Adaptive Control:

- Select **Enable** from the **Adaptive Control** drop-down list.
- Select the **Offset and Span** or **Offset Only** option from the **Adaptive Control Mode** drop-down list.
- In the **Adaptive Control TC** field, specify the time constant of the adaptive control algorithm. This time constant can be used to improve the performance of adaptive control. It is recommended that you use the default value.
14.9 Viewing Selected Live Measurement Parameters

You can view selected "live" measurement parameters.

Figure 14-25 "Live" Variables
This chapter describes how to view and set device configuration parameters for the Quantim device. (For the equivalent device configuration parameters for the SLA Rev A device, see chapter 14). These setting are accessible in the windows of the Device Config->Config Parameters menu.

Some control parameters can be modified, indicated by their field having a white background. Others can only be viewed (and not modified) indicated by their field having a grey background.

**NOTE**: When modifying the values, always remember to click Write to save the values to the device permanently.

When each window is opened, it takes a one-time reading of the parameters. To take another reading, click Read Once. To continuously read the parameters (once per second), click Read Continuous.

The actual parameters accessible/visible may vary depending on the device type and options.

**NOTE**: Any changes you make to the device configuration parameters are saved permanently to the currently connected device. Prior to making changes to device configuration settings, it is recommended that you save the current settings. This will allow you to restore the device configuration to a known, working state (see Section 11.1).

### 15.1 Setting Units of Measure

Change the units of measure for the main measurement parameters. (This applies only to Quantim devices).

![Figure 15-1 Units of Measure](image-url)
15.2 Viewing and Setting Alarms

You can configure the device to report predefined alarm and warning conditions. The alarm and warning parameters are settable using the Service Tool. All alarm and warning conditions are reported to the Service Tool and indicated by green or red flashing codes on the device’s Status and Alarm LEDs. You can also configure alarms and warnings to enable pin 3 of the device’s D-connector.

The following topics provide detailed information about the Diagnostic alarm, which is configured by default, and the optional alarm/warning conditions that be configured.

15.3 Diagnostic Alarm

By default, BEST monitors the device’s Diagnostic alarm status. This is the alarm signal that drives the Status and Alarm LEDs at the top of the device, and that is available to external devices at pin 3 of the device’s D-connector.

The device continuously runs diagnostics. If the diagnostics detect a fatal error, the device goes to a safe state of operation and will not respond to the setpoint. Also, the Status LED turns a solid red and the Alarm LED flashes a red code 7 (7 flashes, followed by brief delay).

Figure 15-2 Alarms -> Diagnostic
15.4 Configuring Optional Warnings and Alarms

In addition to the Diagnostic alarm, you can use BEST to configure the device to report warning and alarm conditions related to the following variables:

- Mass flow
- Volumetric flow
- Density
- Temperature
- Slug flow
- Valve drive
- Setpoint deviation

Each of these variables has a tab in the Alarms tab (the Density tab is shown below as an example – the other tabs show an identical format).

Figure 15-3 Typical Alarm Settings (Density Alarm Shown)
You can globally modify the behavior of alarms to automatically disable when one or both of the following conditions exist: setpoint is zero and valve override is active.

**Setpoint Zero Alarm Disable.** When this option is enabled, the alarms defined in Table 15-2 below will not occur if the setpoint is zero. For example, if the Mass Flow Alarm is enabled and you do not want the alarm to occur while the setpoint is zero (flow is commanded to be zero), causing flow to be less than the lower limit, set the Setpoint Zero Alarm Disable option to On (enabled).

**Valve Override Alarm Disable.** When this option is enabled, the alarms defined in Table 15-2 will not occur if the valve override is in the open or closed state. For example, if the Mass Flow Alarm is enabled and you do not want the alarm to occur while the valve override is set to open, causing flow to exceed the upper alarm limit, then set the Valve Override Alarm Disable option to On (enabled).

### Table 15-1 Affected by Alarm Disable Options

<table>
<thead>
<tr>
<th>Alarm</th>
<th>Setpoint Zero Alarm Disable</th>
<th>Valve Override Alarm Disable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mass Flow</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Volumetric Flow</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Density</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Temperature</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Slug Flow</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Valve Drive</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Setpoint Deviation</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Figure 15-4 Alarms->Configuration (On = Enable, Off = Disable)
15.6 Viewing the Control Response Parameters

Some response parameters on the Control:Response - Pressure tab are settable here. However, it is recommended that you adjust the proportional and integral gain values via the Response Tuning window – (refer also to Section 13.13).

Figure 15-5 Control->Response-Flow

Note that if setpoint Type is changed, the primary output may need to be changed also (see section 15.6)
The Setpoint Type parameter is used to change the setpoint from mass to volume or volume to mass. See Section 5.12 for details.

The two Softstart Ramp parameters allow you to configure the ramp behavior during a soft start of the device.

To configure the softstart ramp behavior, select Ramp Rate from the Softstart Ramp Type drop-down list, then enter the ramp rate (in percent per second) in the Softstart Ramp Rate field.

15.7 Viewing Device Information

Selected device information is shown here. The device information parameters are read-only.

![Device Information](image-url)

Figure 15-7 Device->Device Info
You can view and edit the current settings of the device’s HART protocol parameters.

Figure 15-8 HART Protocol
15.9 Viewing and Setting Primary and Secondary Output Parameters

You can view and edit the current settings of the primary and secondary output parameters from the Configuration Parameters window. You can also modify the output data assignment, the output configuration (voltage or current).

![Figure 15-9 Outputs->Primary Output](image1)

![Figure 15-10 Outputs->Secondary Output](image2)
You can modify the following settings:

- **Out Source.** Specifies the output data assignment.
  The Primary Out Source must match the Setpoint Type assignment (see Figure 15-6). If you are changing from mass to volume or volume to mass this field must be changed.

- **Analog Output Config.** Specifies the type of analog output—voltage or current.

- **Out Alarm Behavior** (QUANTIM QMA only). Specifies the behavior of the output during an alarm condition.

  The Output Alarm Behavior choices are:
  - **Downscale.** Output will go to minimum.
  - **Hold.** Output will remain at the value in effect when the alarm condition was detected.
  - **Track.** Output will continue to report the value of the measured process variable.
  - **Upscale.** Output will go to maximum.
15.10 Viewing Sensor Parameters

Figure 15-11 Sensor->Zero

Figure 15-12 Sensor->Flow Calibration
Figure 15-13 Sensor->Density Cal

Figure 15-14 Sensor->Status
15.11 Viewing Setpoint Parameters

![Image of Quantim Configure Parameters window showing setpoint parameters]

Figure 15-15 Setpoint->Flow
15.12 Viewing Valve Parameters

To adjust the valve parameters, refer also to Sections 13.13.

Figure 15-16 Valve->Adjust - Flow

Figure 15-17 Valve->Config - Flow
15.13 Viewing Selected Live Measurement Parameters

You can view selected “live” measurement parameters.

Figure 15-18 Valve -> Adaptive Control - Flow

Figure 15-19 Variables -> Mass Flow
Figure 15-20 Variables -> Volumetric Flow

Figure 15-21 Variables -> Temperature
Figure 15-22 Variables->Density
LIMITED WARRANTY
Visit www.BrooksInstrument.com for the terms and conditions of our limited warranty.

BROOKS SERVICE AND SUPPORT
Brooks is committed to assuring all of our customers receive the ideal flow solution for their application, along with outstanding service and support to back it up. We operate first class repair facilities located around the world to provide rapid response and support. Each location utilizes primary standard calibration equipment to ensure accuracy and reliability for repairs and recalibration and is certified by our local Weights and Measures Authorities and traceable to the relevant International Standards.

Visit www.BrooksInstrument.com to locate the service location nearest to you.

START-UP SERVICE AND IN-SITU CALIBRATION
Brooks Instrument can provide start-up service prior to operation when required.
For some process applications, where ISO-9001 Quality Certification is important, it is mandatory to verify and/or (re)calibrate the products periodically. In many cases this service can be provided under in-situ conditions, and the results will be traceable to the relevant international quality standards.

CUSTOMER SEMINARS AND TRAINING
Brooks Instrument can provide customer seminars and dedicated training to engineers, end users and maintenance persons.

Please contact your nearest sales representative for more details.

Due to Brooks Instrument’s commitment to continuous improvement of our products, all specifications are subject to change without notice.

TRADEMARKS
Brooks is a trademark of Brooks Instrument, LLC
All other trademarks are the property of their respective owners.